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Preface

As part of an effort to improve and enhance the performance and capabilities 
of its product lines, EMC periodically releases revisions of its hardware and 
software. Therefore, some functions described in this document may not be 
supported by all versions of the software or hardware currently in use. For 
the most up-to-date information on product features, refer to your product 
release notes.

If a product does not function properly or does not function as described in 
this document, please contact your EMC representative.

Audience This document is part of the ViewPoint for SAP documentation set, 
and is intended for use by the ViewPoint for SAP modules utilities 
administrator. 

Readers of this document are expected to be familiar with the 
following topics:

◆ ViewPoint for SAP modules installation and usage

◆ SAP generic installation tools and programs
EMC ViewPoint for SAP Modules Utilities User Manual 7
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Preface
Related
Documentation

Related documents include:

Introductory
◆ EMC ViewPoint for SAP Release Notes

Installation
◆ EMC ViewPoint for SAP Software Suite Installation Manual

Administrative
◆ EMC ViewPoint for SAP Modules Administration Manual

User
◆ EMC ViewPoint for SAP Modules Utilities User Manual

Conventions Used in
This Guide

EMC uses the following conventions for special notices.

Note: A note presents information that is important, but not hazard-related.

CAUTION!
A caution contains information essential to avoid data loss or 
damage to the system or equipment. The caution may apply to 
hardware or software.

IMPORTANT!
An important notice contains information essential to operation of 
the software. The important notice applies only to software.
EMC ViewPoint for SAP Modules Utilities User Manual



Preface
Typographical Conventions
EMC uses the following type style conventions in this guide:

Where to Get Help EMC support, product, and licensing information can be obtained as 
follows.

Normal Used in running (nonprocedural) text for:
• Names of interface elements (such as names of windows, 

dialog boxes, buttons, fields, and menus)
• Names of resources, attributes, pools, Boolean expressions, 

buttons, DQL statements, keywords, clauses, environment 
variables, filenames, functions, utilities

• URLs, pathnames, filenames, directory names, computer 
names, links, groups, service keys, file systems, notifications

Bold: Used in running (nonprocedural) text for:
• Names of commands, daemons, options, programs, 

processes, services, applications, utilities, kernels, 
notifications, system call, man pages

Used in procedures for:
• Names of interface elements (such as names of windows, 

dialog boxes, buttons, fields, and menus)
• What user specifically selects, clicks, presses, or types

Italic: Used in all text (including procedures) for:
• Full titles of publications referenced in text
• Emphasis (for example a new term)
• Variables

Courier: Used for:
• System output, such as an error message or script 
• URLs, complete paths, filenames, prompts, and syntax when 

shown outside of running text. 

Courier bold: Used for:
• Specific user input (such as commands) 

Courier italic: Used in procedures for:
• Variables on command line
• User input variables 

< > Angle brackets enclose parameter or variable values supplied by 
the user

[ ] Square brackets enclose optional values

| Vertical bar indicates alternate selections - the bar means “or”

{ } Braces indicate content that you must specify (that is, x or y or z)

... Ellipses indicate nonessential information omitted from the 
example
EMC ViewPoint for SAP Modules Utilities User Manual 9



10

Preface
Product information — For documentation, release notes, software 
updates, or for information about EMC products, licensing, and 
service, go to the EMC Powerlink website (registration required) at:

http://Powerlink.EMC.com

Technical support — For technical support, go to EMC Customer 
Service on Powerlink. To open a service request through Powerlink, 
you must have a valid support agreement. Please contact your EMC 
sales representative for details about obtaining a valid support 
agreement or to answer any questions about your account.

Your Comments Your suggestions will help us continue to improve the accuracy, 
organization, and overall quality of the user publications. Please send 
your opinion of this guide to:

techpub_comments@EMC.com 
EMC ViewPoint for SAP Modules Utilities User Manual
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This chapter introduces the ViewPoint for SAP utilities and includes 
this topic:

◆ Overview............................................................................................. 12

ViewPoint for SAP
Utilities
ViewPoint for SAP Utilities 11
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ViewPoint for SAP Utilities
Overview
The ViewPoint for SAP utilities can be grouped into three categories:

◆ “Installation utilities”

◆ “Compliance and auditing utilities” on page 13

◆ “Database growth monitoring utility” on page 13

The latest ViewPoint for SAP transport version information is in the 
EMC ViewPoint for SAP Release Notes.

Complete ViewPoint for SAP transport installation information is in 
the EMC ViewPoint for SAP Software Suite Installation Manual.

The latest ViewPoint for SAP documentation is on EMC Powerlink.

Installation utilities This section describes the ViewPoint for SAP utilities used during 
installation.

Initial installation The following utilities are supplied as a single transport installed 
during the initial installation of ViewPoint for SAP.

Archive Browser
Archive Browser is a utility that displays table entries, and the 
corresponding table and text field values.

Conversion Tool
Conversion Tool is a utility used to adjust simple ABAP/4 programs 
to archiving purposes.

Translation Tool
Translation Tool is a utility that translates standard SAP objects’ text 
elements and dynpros into the user’s native language for use by 
ViewPoint for SAP to display corresponding objects’ text elements 
and dynpros.

Check ADK
Check ADK is a utility that is an error analysis tool used in case of 
access problems to ViewPoint for SAP index files or SAP archive files.

Class Order Class Order is supplied as a separate transport and is a utility that 
helps manage the installation of technically-related archive modules.
EMC ViewPoint for SAP Modules Utilities User Manual



ViewPoint for SAP Utilities
Compliance and 
auditing utilities

This section describes the ViewPoint for SAP utilities useful for 
compliance and auditing purposes.

Fiscal Year Reporter Fiscal Year Reporter is supplied as a separate transport and is a utility 
that helps manage the numerous fiscal year tasks that have to be 
carried out in the area of financial accounting at years’ end.

Data Retention Tool Data Retention Tool (CDART) is supplied as a separate transport and 
is a utility that helps create datasets from active and archived data, in 
SAP certified format, for external auditing purposes.

Database growth 
monitoring utility

This section describes the ViewPoint for SAP utility used to monitor 
database size and health.

Analyzer Plus Analyzer Plus is supplied as a separate transport and is a utility that 
analyses archiving tables capacity, analyzes the distribution of 
documents, and executes an archiving check.
Overview 13
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This chapter covers the ViewPoint for SAP Archive Browser and 
includes these topics:

◆ Overview............................................................................................. 16
◆ Starting Archive Browser.................................................................. 18
◆ Displaying Archiver Browser accessible tables ............................. 20
◆ Selecting tables ................................................................................... 21
◆ Database table /PBS/TAB_ARCHDEF .......................................... 26
◆ Preselected tables ............................................................................... 27

Archive Browser
Archive Browser 15
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Archive Browser
Overview
The ViewPoint for SAP Archive Browser is the EMC counterpart of 
the SAP Data Browser which uses transaction SE16. The ViewPoint 
for SAP Archive Browser displays table entries, table field values, 
and text field values using the database, archive, or both as a data 
source.

The Archive Browser displays tables from these ViewPoint for SAP 
modules:

◆ Financial Accounting and Material Documents (CFI)

◆ Sales and Distribution (CSD)

◆ Purchasing (CMM)

◆ Material Master Data, Batches/Special Stocks and BOMs (CMT)

◆ Controlling Line Items (CCO)

◆ Profit Center Line Items (CPCA)

◆ Plant Maintenance (CPM)

◆ Production Orders (CPP)

◆ Process Orders (CPR)

◆ Project Systems (CPS)

◆ Warehouse Management (CWM)

◆ Special Ledger (CSL)

◆ Custom [(IDK) CUSTOM]

Objects Table 1 lists the SAP R/3 objects included in the Archive Browser 
utility with a description of each object.

Table 1 Archive Browser object descriptions

Object Rel. 3.x Rel. 4.x Description

PROG ZZCSBROW /PBS/UTIL_ARCHIVEBROWS Archive Browser

FUGR Z007 /PBS/C007 Function group for Conversion objects

FUGR ZZSB /PBS/SETB Function group Archive Browser (AB)
EMC ViewPoint for SAP Modules Utilities User Manual
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FUGR N/A /PBS/TAB_ARCHDEF Function group for DB table where all available 
ViewPoint for SAP modules (transaction /PBS/SE16), 
their tables and indexes have been stored.

PROG ZZABHELP /PBS/AB_HELPRQ Help Request for AB

PROG ZZABCODE N/A Code generation for AB

PROG N/A /PBS/TAB_ARCHDEF Delete table entries of /PBS/TAB_ARCHDEF with 
TAB_TYPE EQ SPACE

TABL N/A /PBS/TAB_ARCHDEF DB table where all available ViewPoint for SAP modules 
(transaction /PBS/SE16), their tables and indexes have 
been stored

TABU N/A /PBS/TAB_ARCHDEF Entries for ViewPoint for modules, their tables and 
indexes

TRAN ZZ16 /PBS/SE16 Start transaction

Table 1 Archive Browser object descriptions (continued)

Object Rel. 3.x Rel. 4.x Description
Overview 17
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Archive Browser
Starting Archive Browser
Follow this procedure to start ViewPoint Archive Browser.

1. Execute transaction:

/PBS/SE16 (release 4.0 and later),

or ZZ16 (release 3.x and prior),

or navigate through the ViewPoint menu via /PBS/EMC (release 
4.0 and later),

or YPBS (release 3.x and prior)

2. In the ViewPoint for SAP menu, select Utilities > General tools > 
Archive Browser.

The utilities menu screen appears, as shown in Figure 1 or 
Figure 2 on page 19.

Figure 1 ViewPoint for SAP utilities releases 4.0 and 4.5
EMC ViewPoint for SAP Modules Utilities User Manual
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Figure 2 ViewPoint for SAP utilities release 4.6
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Archive Browser
Displaying Archiver Browser accessible tables
To display the list of Archive Browser accessible tables for use with 
transaction /PBS/SE16, place the cursor in the table name field of the 
initial screen of the Archive Browser and press F4 or click Enter .

The list of available tables appears, as shown in Figure 3.

Figure 3 Archive Browser accessible tables
EMC ViewPoint for SAP Modules Utilities User Manual
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Selecting tables
Follow this procedure to select ViewPoint for SAP module tables 
using Archive Browser.

1. Make entries in the Archive Browser initial screen fields, as 
shown in Figure 4 and defined in Table 2.

2. Click Enter .

Figure 4 Archive Browser initial screen

Table 2 Archive Browser screen field definitions

Field Definition

Table name Enter the table name.

Note: This procedure uses table BKPF from the 
Financial Accounting and Material Documents (CFI) 
module as an example.
Selecting tables 21
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Archive Browser
The table (BKPF) index screen appears, as shown in Figure 5.

Figure 5 Table BKPF index screen

Archive Enter the name of the ViewPoint for SAP module if the 
table exists in several ViewPoint for SAP modules.

Option This field is used to query CSD module tables for orders, 
delivery notes, invoices, etc.

1=Arch.+Db 2=Db 3=Archive Enter whether the tables should be displayed from the:
• Database and archives (1)
• Database only (2) (calls SAP Data Browser 

transaction SE16)
• Archives only (3) (of the previously selected table)

Note: If a table is available in the different module 
archives, you have to delimit exactly. For example the 
table CDHDR is available in the CFI, CMM, and CSD 
modules.

Table 2 Archive Browser screen field definitions (continued)

Field Definition
EMC ViewPoint for SAP Modules Utilities User Manual
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3. Select an index combination.

Include as many fields as possible for later selection and index 
sequential data reading, thereby shortening query run time.

Note: When there is only one index for a table within the selection of a 
ViewPoint for SAP module, the field selection list displays.

For example, selecting the indexes BUKRS and BELNR generates 
a display in which both index fields are marked and can’t be 
deselected. However, you can select additional search fields, as 
shown in Figure 6.

Figure 6 Example of selected and potential index field combinations

4. Click Enter to confirm the entries.
Selecting tables 23
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Archive Browser
The selection screen with the selected indexes appears, as shown 
in Figure 7. The index fields and possible additional fields for this 
table are displayed in this selection screen.

Figure 7 Selection screen for table BKPF

5. Enter the field delimiters.

Enter delimiters for the index fields, and for the primary index in 
particular. Without entries the query runs through all data 
records resulting in long run time (depending on data volume). If 
the primary index is not delimited and error message appears, as 
shown in Figure 8.

Figure 8 Error message for primary key with no delimitation

The index fields with delimiters appears, as shown in Figure 9.

Figure 9 Table BKPF delimiters

6. Click Enter.
EMC ViewPoint for SAP Modules Utilities User Manual
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The query results for the example delimiters displays, as shown 
in Figure 10.

Figure 10 Query results with delimiters

Column A is marked with an asterisk (*) for archived documents 
and is empty for documents still available in the database.

Note: To view the data in the ALV display, first display the data using 
SE16 and then switch to the ALV display.
Selecting tables 25
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Archive Browser
Database table /PBS/TAB_ARCHDEF
The Archive Browser displays tables and their contents accessible 
with the function module /PBS/SELECT_INTO_TABLE when 
created in the database table /PBS/TAB_ARCHDEF.

This table (structure) and contents are delivered as objects of the 
Archive Browser transport, as shown in Figure 11.

Figure 11 Extract of table /PBS/TAB_ARCHDEF contents

The field TAB_TYPE defines if the table is:

◆ delivered from SAP  (TAB_TYPE = 1)

◆ customer-specific (TAB_TYPE = 2)
EMC ViewPoint for SAP Modules Utilities User Manual
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Preselected tables
Some tables, for example table EIKP in the ViewPoint for SAP MM 
module, can be accessed with index fields that are not in the table 
structure, as shown in Figure 12.

Figure 12 Table EIKP index fields

None of the indicated index fields - in this example EBELN, LIFNR, 
and MATNR of table EIKP - is a field in this table structure.
Preselected tables 27
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Archive Browser
Selecting the document number as an index field for a selection adds 
it to the table structure, as shown in Figure 13.

Figure 13 Table EIKP selection fields list

The checkbox for the selected index field EBELN is marked 
automatically because the selection has to be made for at least one or 
more index fields.

Note: Option 1 (access to archive and database data) cannot be used for tables 
that include index fields that were added automatically. You can access only 
the database or the archive data for these tables, or the Option 1 (parameter) 
error message appears, as shown in Figure 14.

Figure 14 Option 1 error message
EMC ViewPoint for SAP Modules Utilities User Manual



Archive Browser
Selecting a table shared by ViewPoint for SAP modules reveals other 
index possibilities. For example, only one index for table EIKP can be 
selected with the ViewPoint for SAP CSD module displaying table 
EIKP, as shown in Figure 15.

Figure 15 Selection fields list for CSD table EIKP
Preselected tables 29
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Archive Browser
List of tables Place the cursor in the table name field and press F4, or click 
selection, to view the tables that archived data is accessible. The 
selection of available tables appears, as shown in Figure 16. 

Figure 16 List of available database tables
EMC ViewPoint for SAP Modules Utilities User Manual
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This chapter addresses the administrative adjustment of ViewPoint 
for SAP modules using the ViewPoint for SAP Conversion Tool. The 
Conversion Tool is supplied as part of the ViewPoint for SAP 
modules utilities.

This chapter includes these topics:

◆ Overview............................................................................................. 32
◆ Running the Conversion Tool .......................................................... 33
◆ Special features................................................................................... 41
◆ Sample programs ............................................................................... 43
◆ Archive access tutorial (SAP version 4.6c) ..................................... 44

Conversion Tool
Conversion Tool 31
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Conversion Tool
Overview
The ViewPoint for SAP Conversion Tool adjusts ABAP/4 programs 
by searching for Select commands using a ViewPoint for SAP 
module.

The ViewPoint for SAP Conversion Tool converts Select command 
structures into a Loop structure.

Note: Check converted Select and Loop commands during and after the 
conversion. You cannot adjust each Select command for each archive module.

The ViewPoint for SAP Conversion Tool works with the following 
ViewPoint for SAP modules:

◆ Controlling Line Items (CCO)

◆ Financial Accounting and Material Documents (CFI)

◆ Purchasing (CMM)

◆ Sales and Distribution (CSD)

Table 3 lists the Conversion Tool objects.

Table 3 ViewPoint for SAP Conversion Tool object descriptions

Object ViewPoint for SAP 4.x ViewPoint for SAP 3.x Description

PROG /PBS/UTIL_CONVERT SAPMYCON Conversion Tool

PROG /PBS/UTIL_CONV_DUMMY ZZZDUMMY Dummy program

FUGR /PBS/UTIL_CONVERT ZARC Function group for archive access

TRAN /PBS/UTIL_CONVERT YCON Start transaction
EMC ViewPoint for SAP Modules Utilities User Manual
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Running the Conversion Tool
Follow the procedures in this section to convert an ABAP/4 program 
for use with a ViewPoint for SAP module.

Note: The procedures in this section use YYCONV02 as an example program 
to help explain the conversion done by the Conversion Tool.

Starting the 
conversion

Follow this procedure to start the conversion.

1. Start the ViewPoint for SAP Conversion Tool with transaction:

/PBS/UTIL_CONVERT (version 4.x)

or YCON (version 3.x)

or from the ViewPoint for SAP main menu using Utilities > 
General tools > Conversion Select Command

The Conversion Tool window appears, as shown in Figure 17.

Figure 17 Conversion Tool window

2. Indicate Source and Target program.
Running the Conversion Tool 33
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Conversion Tool
Note: The default Target program is ZZZDUMMY.

You can Change, Display, Copy, and Execute the Source and 
Target programs.

Use Copy to convert a Source program into a Target program 
other than ZZZDUMMY. During the copy process change the 
default Target program name ZZZDUMMY to the desired 
program name.

3. Start the conversion by clicking start converting, as shown in 
Figure 18.

Figure 18 Start converting

The coding lines of the program (YYCONV02 in this example) are 
converted for the ViewPoint for SAP modules and can be stored 
in the program ZZZDUMMY, by default.

4. Cut and paste, or use PC Download, to enter the coding into the 
desired program.
EMC ViewPoint for SAP Modules Utilities User Manual
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Viewing conversion
results

An example of conversion results appears in table form with a table 
line entered for each Select command found during the conversion, 
as shown in Figure 19.

Figure 19 Conversion results

The columns contain information on the conversion of the Select 
command.
Running the Conversion Tool 35
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Conversion Tool
Status of the conversion (St.)
Table 4 lists definitions for the status symbols shown in the first 
column.

Sequential number (CurNo.)
The sequential number assigned to each Select command.

Line (Row)
The line number of the Select command in the Source program.

Module
The name of the ViewPoint for SAP module addressed by the Select 
command.

Option
The option required for access to some ViewPoint for SAP modules. 
For example, in the ViewPoint for SAP CSD module, this option is 
used to determine if the access is to be made to orders (A), delivery 
notes (L) or invoices (F). The ViewPoint for SAP CFI and CMM 
modules have no options.

Table 4 Status table column definition

Symbol Definition

The Select was converted automatically and the Conversion Tool found all the 
necessary information for the conversion.

The Select could not be converted because the table is not supported by 
ViewPoint for SAP. The table is either a system table or a master records 
table.

The conversion has later modifications.

An external program call was found in the source program (Include, Perform, 
or Call).

Single Select lines excluded from the conversion display this symbol.

Manual editing is necessary because, during the conversion, no key field was 
found for access to the ViewPoint for SAP module, or the database table can 
exist in several ViewPoint for SAP archives.
EMC ViewPoint for SAP Modules Utilities User Manual
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Table
The dictionary table addressed by the Select command (FROM 
statement).

Performance
The performance of access to the ViewPoint for SAP module. Table 5 
lists performance symbol definitions.

Field 1, Field 2, Field 3, Field 4
Displays the name of the key field used to access the ViewPoint for 
SAP archive.

Definition of the function keys
F2 —  compares the source and the target program.

F6 —  allows the manual editing of the conversion.

F11 —  saves the result of the conversion under the name of the target 
program.

Editing conversion Each conversion can be edited manually to change the ViewPoint for 
SAP module option.

Table 5 Performance symbol definitions

Symbol Definition

Red displays when there is no access to the ViewPoint for SAP 
module.

Yellow displays when trying to access the ViewPoint for SAP archive 
with an unsupported key field.

Green display when there is optimal access to the ViewPoint for SAP 
module.
Running the Conversion Tool 37
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Conversion Tool
For the key fields 1 to 4 type the field name, the from/to values, and 
select option, as shown in Figure 20.

Figure 20 Process conversion

Press F11 to save the changes. In the table overview, the Select line is 
now marked with the status Modified conversion. The performance 
display is not changed.

Press Shift+F7 to prevent the select line from being converted. The 
status symbol No conversion appears.
EMC ViewPoint for SAP Modules Utilities User Manual
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Display Source and 
Target program

The Source and the Target programs both have current line numbers 
of the Select command, as shown in Figure 21.

Figure 21 Comparing Source and Target programs
Running the Conversion Tool 39
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Conversion Tool
Customizing 
definitions

Use the Customizing sequence to access the ViewPoint for SAP 
modules (ranking) definition, as shown in Figure 22.

Figure 22 Determine module sequence

This definition is always valid when a database table used in a Select 
command is contained in several ViewPoint for SAP modules.

If the Source program contains, for example, the Select command ...

SELECT * FROM EIPO

... the Source program is converted for access to the invoices of the 
ViewPoint for SAP SD Module. However, the table EIPO can (in 
addition to the invoices) also exist in delivery notes and purchasing 
(MM) documents.

When converting a program for purchasing documents, modify this 
sequence in a way so that the module MM receives ranking #1 with 
the rest having a lower ranking. Tables STXH, CDHDR require 
checking and defining sequential order.

Tables contained in multiple ViewPoint for SAP modules always 
have a status of Manual editing necessary.
EMC ViewPoint for SAP Modules Utilities User Manual
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Special features
This section explains why Select statements have not been converted 
or whose conversion was partly wrong.

Client specified Access to ViewPoint for SAP modules always depends on the client. 
Remove this clause.

Package Size n The Conversion Tool is immediately cancelled with the error 
message:

Source program not checkfree or unknown SQL statement in 
line 40

Remove the clause "Package size n" and the corresponding 
ENDSELECT command from the source program.

Up to n rows Not supported — target program is not checkfree.

Group by Not supported — target program is not checkfree.

Aggregate 
functions

Aggregate functions like MAX, MIN, SUM, COUNT, AVG are not 
supported. 

Like The program is not checkfree because loop does not support the 
statement Like.

Distinct The Select clause Distinct is supported by the Conversion Tool by 
deleting from the created internal table all multiple entries with the 
instruction.

Delete Adjacent 
Duplicated from 
iTAB

Ensure that the table is sorted and that duplicate deletion always 
relates to the internal table primary key.

Bypassing Buffer Not considered.
Special features 41



42

Conversion Tool
Sy-Subrc The correction of the system variables SY-SUBRC is only integrated 
into the target program in case of a SELECT-INTO-TABLE.

Transfer of key 
values or select 
options

If in the WHERE statement of the SELECT command a direct value 
entry and a select option are found, the SELECT option is transferred. 
The direct value entry is then checked with the loop.
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Sample programs
The sample programs, as shown in Figure 23, are meant for 
Conversion Tool testing purposes only.

Figure 23 Conversion Tool testing programs
Sample programs 43
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Archive access tutorial (SAP version 4.6c)
Manual ABAP/4 programs with ViewPoint for SAP archive access 
are provided if an automatic adjustment cannot be made with the 
ViewPoint for SAP Conversion Tool.

From SAP version 4.6c, ViewPoint for SAP has archive access 
tutorials which enable application developers to provide 
customer-specific programs with ViewPoint for SAP archive access. 
Executable example programs are provided for each installed 
ViewPoint for SAP module. Their coding can be processed and 
executed with the ABAP workbench.

Call the function under General tools, as shown in Figure 24.

Figure 24 General tools functions

Or use transaction: /PBS/UTIL_ACCESS_ARC.

ABAP Editor Click ABAP Editor to start the editor and display sample programs. 
Breakpoints can be set to execute the programs or the relevant coding 
can be marked to transfer it into the customer program.

Execute The sample program is started and the selected archive data is 
displayed in a list.
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The ViewPoint for SAP Translation Tool is supplied as part of the 
ViewPoint for SAP modules utilities.

This chapter includes these topics:

◆ Overview............................................................................................. 46
◆ Running the Translation Tool ........................................................... 47

Translation Tool
Translation Tool 45
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Overview
The ViewPoint for SAP Translation Tool translates text elements and 
dynpros of SAP standard objects to the text elements and dynpros of 
the corresponding ViewPoint for SAP object in any language, 
maintaining the texts of reports, function groups, logical databases 
and transactions program elements.

Note: The Translation Tool translates SAP texts in the chosen language only. 
Texts in other languages will not be affected.

Be sure of the program elements selected for translation because existing text 
in the chosen language is overwritten.

Contact EMC Support for more information.

Delivery Table 6 lists the Translation Tool objects.

Table 6 ViewPoint for SAP Translation Tool object descriptions

Object ViewPoint for SASP 3.x ViewPoint for SAP 4.x Description

PROG ZZTRANSL /PBS/UTIL_TRANSLATE Translation Tool

TRAN ZTRA /PBS/UTIL_TRANSL Start transaction

TABL ZZUTILTRAN /PBS/UTIL_TRANSL Table
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Running the Translation Tool
Follow this procedure to translate text elements for use with a 
ViewPoint for SAP module.

1. Start the ViewPoint for SAP Conversion Tool with transaction:

/PBS/UTIL_TRANSL (version 4.0 and after)

or ZTRA (version 3.1 and prior)

The Translation Tool window appears, as shown in Figure 25.

Figure 25 Translation Tool window
Running the Translation Tool 47
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Table 7 lists the initial screen fields definitions.

Figure 26 Direct choice of objects

Table 7 Translation Tool initial screen fields

Field Definition

Target language Select the language(s) into which you want to 
translate.

Enter transport request
(optional when using Direct choose 
of objects)

Enter the desired transport request to translate all 
existing programs (PROG), function groups 
(FUGR), logical databases (LDBA) and transactions 
(TRAN) of the transport. The Translation Tool 
attempts to find the original name of the program 
element with the given ViewPoint for SAP program 
name.
Selecting multiple transport requests could impede 
performance of the Translation Tool.

Already translated objects also Select to overwrite existing text elements of the 
selected objects already in the target language.

Direct choose of objects
(optional when entering a transport 
request)

Enter the original program name matching a 
ViewPoint for SAP program when there are few 
elements to edit or no original program name can 
be found, as shown in Figure 26.
Be sure of the order of the select options when 
selecting several objects.

Mode
(select one)

• Text elements
Text elements of the selected objects will be 
processed.

• Screen painter-Dynpros
Screen painter-Dynpros of the selected objects 
will be processed.

• All
Both text elements and screen painter-Dynpros 
of the selected objects will be processed.
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2. Press Execute in the initial screen.

A list displays three types of objects:

• objects the tool has found an original name

• objects where no original name was found

• objects where no clear original name was found

3. Double-click the objects for which an original name has been 
found, as shown in Figure 27, or select them using the checkbox.

You can also select and deselect all found objects using Shift+F1 
and Shift+F2.

Figure 27 Selection of objects

4. Press Execute.

All selected text elements are copied from the original program to 
the ViewPoint for SAP program and a report of changes displays.
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The ViewPoint for SAP Check ADK utility is supplied as part of the 
ViewPoint for SAP modules utilities and does not need any other 
ViewPoint for SAP transports to be previously imported.

The Check ADK runs with the basis programs of SAP AG, D-69190 
Walldorf/Baden, system R/3, releases 4.0, 4.5, 4.6, R/3 Enterprise 
correction levels a to c.

This chapter includes these topics:

◆ Overview............................................................................................. 52
◆ Running Check ADK......................................................................... 53

Check ADK
Check ADK 51
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Check ADK
Overview
The ViewPoint for SAP Check ADK utility serves as an error analysis 
tool in case of access problems to ViewPoint for SAP index files or 
SAP archive files. The Check ADK transport does not require another 
ViewPoint for SAP transport and can be run independently of any 
type and number of installed ViewPoint for SAP modules.

The Check ADK Utility checks the following ViewPoint for SAP 
modules:

◆ Production Orders (CPP)

◆ Controlling Line Items (CCO)

◆ Plant Maintenance (CPM)

◆ Material Master Data, Batches/Special Stocks and BOMs (CMT)

◆ Process Orders (CPR)

◆ Costing-Based Profitability Analysis (CCOPA)

◆ Master Data Changes (CCU)

◆ Purchasing (CMM)

◆ CO Orders (COO)

◆ CO Line Items (CPCA)

◆ Project Systems (CPS)

◆ Line Items in FI-SL (CSL)

◆ Warehouse Management (CWM)

◆ HR Archiving  Objects (CHR)

◆ Financial Accounting and Material Documents (CFI)

◆ Sales and Distribution (CSD)

Table 8 lists the Check ADK objects.

Table 8 Check ADK objects

Object ViewPoint for SAP 4.x Description

PROG /PBS/UTIL_CHECK_PBS_ADK Report ViewPoint Check ADK utility

DEVC /PBS/UTIL Development Class /PBS/UTIL

TRAN /PBS/CHECK_PBS_ADK Transaction ViewPoint Check ADK utility
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Running Check ADK
Follow this procedure to use the Check ADK utility.

1. Start the Check ADK utility with transaction 
/PBS/CHECK_PBS_ADK, as shown in Figure 28.

Figure 28 ViewPoint for SAP utilities releases 4.0 and 4.5

Or from the ViewPoint for SAP main menu using Utilities > 
General tools > Tool Check ViewPoint ADK, as shown in 
Figure 29.

Figure 29 ViewPoint for SAP utilities menu release 4.6
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The Check ADK initial screen appears.

2. Select one or more ViewPoint for SAP modules, as shown in 
Figure 30.

Also choose between:

• only errors for a quick ADK check

• all messages for a complete ADK check

Note: For information on selecting SAP - Object to Test, proceed to 
“Using SAP - Object to Test” on page 56.

Figure 30 Check ADK initial screen

3. Select Execute to confirm your selections.
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A sample results screen appears, as shown in Figure 31.

Figure 31 Results screen for the ViewPoint for SAP CPR module

Table 9 lists the results definitions, which are divided into several 
parts, depending on the ViewPoint for SAP module.

Note: FAIL displays if an ADK file cannot be accessed.

Table 9 Results screen definitions

Screen area Definition

Check of the ViewPoint ADK files 
with table ADMI_RUN

All available ViewPoint for SAP index files for one 
module are checked.

Check of the ViewPoint ADK files 
with PBS-ADMIN table

All activated ViewPoint for SAP index files for one 
module are checked (Load. Admin.table)

Check of the ViewPoint ADK files 
with the COMMENTS entry (CPP 
and CHR Modules)

Check of the SAP-ADK files for 
activated indices (LAUFTAB) 
(remaining modules)

Comments entered in the SAP original ADK files 
are checked if a ViewPoint for SAP index exists.

SAP-ADK files processed in individual load runs are 
checked.

Check for not loaded ADK files All remaining ADK files are checked.
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Using SAP - Object 
to Test

Use this procedure to check SAP-ADK files exclusively using Check 
ADK.

1. Select SAP - Object to Test in the Check ADK initial screen, as 
shown in Figure 30 on page 54.

2. Enter one archiving object.

A sample results screen appears, as shown in Figure 32.

Figure 32 Results screen for SAP object FI_DOCUMNT
EMC ViewPoint for SAP Modules Utilities User Manual
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ViewPoint for SAP Class Order is an administrative tool for use with 
Development Class /PBS/ORDER.

This chapter includes these topics:

◆ Overview............................................................................................. 58
◆ Development Class /PBS/ORDER ................................................. 59

Class Order
Class Order 57
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Class Order
Overview
ViewPoint for SAP Class Order applies to the following ViewPoint 
for SAP modules:

◆ Project Systems (CPS)

◆ Production Orders (CPP)

◆ Plant Maintenance (CPM)

◆ Process Orders (CPR)

As these modules’ functionalities are closely related, there is also a 
close relationship between program sources. The ViewPoint for SAP 
Class Order module was created to handle any version management 
issues.
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Development Class /PBS/ORDER
Class Order addresses rare situations where installing different 
modules with partly overlapping objects may cause an older 
transport to overwrite newer objects in a related transport by 
combining those objects into one module transport. These objects are 
integrated in the Development Class /PBS/ORDER.

The development class /PBS/ORDER is not a full ViewPoint for SAP 
module. It is a part of the ViewPoint for SAP modules CPP, CPM, 
CPR, and CPS. Import of the development class /PBS/ORDER when 
using one these modules.

When using more than one of these modules, import the 
development class /PBS/ORDER only once.

Since the Development Class /PBS/ORDER corrects any potential 
overlapping and overwriting object issues, import the ViewPoint for 
SAP module transports and the Development Class /PBS/ORDER 
transport in any order.
Development Class /PBS/ORDER 59
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This chapter includes these topics:

◆ Overview............................................................................................. 62
◆ Using Fiscal Year Reporter................................................................ 64
◆ Extracting fiscal year closing transaction data............................... 65
◆ Extract master data at fiscal year closing........................................ 67
◆ Fiscal Year Reporting......................................................................... 70
◆ Fiscal Year Reporter audit access ..................................................... 71
◆ Administration ................................................................................... 82

Fiscal Year Reporter
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Fiscal Year Reporter
Overview
At the end of a fiscal year numerous financial accounting tasks must 
be completed, such as reconciliation and documenting posting 
material.

With Fiscal Year Reporter such tasks are carried out independently of 
the everyday business of the SAP system. As soon as the fiscal year is 
completed, all documents and transaction figures for the fiscal 
period, including the corresponding master data information, are 
saved outside the SAP tables. Document information is saved in ADK 
format under a user defined archiving object while the master record 
information is stored in compressed form in a SAP cluster table. 
During the generation process of the fiscal year stock, the transaction 
figures are reconciled with the transactions of the period on company 
code level.

The predefined, year end closing programs of the Fiscal Year 
Reporter has a process flow, as shown in Figure 33.

Figure 33 Fiscal Year Reporter process flow

The Fiscal Year Reporter provides the following advantages for the 
SAP financial accounting business processes:

 
A rc h iv e  d a ta

F I_D O C U M N T

R / 3  D ata b a s e

D o c u m e n t +  m a s te r re c o rd

F isc a l  y e a r  r e c o r d e r

1 9 9 9

2 0 0 0

... .

D o c u m e n t M a ste r  r e c o r d

In c l . 
r e c o n c il ia tio n

F isc a l  y e a r  r e p o r te rY e a r
EMC ViewPoint for SAP Modules Utilities User Manual



Fiscal Year Reporter
◆ Freezing actual status of movement and master data at the end of 
the fiscal year

◆ Evaluation of fiscal year data after conversion of local currency 
values

◆ Complete independence from the development of the operative 
SAP tables

◆ Balances audit trail programs and quantity problems with sort 
volumes

◆ Easily integrates customer/SAP programs with the Fiscal Year 
Reporter
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Using Fiscal Year Reporter
There are two Fiscal Year Reporter menus:

◆ User — transaction YEAR (/PBS/YEAR/)

◆ Administrative — transaction YEAM (/PBS/YEAM)

Note: Transaction YEAM contains administrative functions that should be 
made available to administrative personnel only.

The fiscal year reporter menu displays using transaction YEAR or 
YEAM, as shown in Figure 34.

Figure 34 Start menu YEAR/YEAM

For SAP versions 4.6 and later, create a user and administrator 
activity group integrating the range menus /PBS/YEAM and 
/PBS/YEAR. SAP standard documentation contains more details on 
creating activity groups.

Enter the activity group in the user master record, as shown in 
Figure 35.

Figure 35 Activity group user master record
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Extracting fiscal year closing transaction data
ViewPoint for SAP FYR uses archiving object YY_YR_yyyy (where 
yyyy is fiscal year) to copy all transactions belonging to a fiscal year, 
regardless of status (e.g., open or cleared), to an SAP ADK file. The 
archiving object is generated during run time if it does not yet exist. 
This allows the complete display of all the posting material for any 
time, such as a balance audit trail.

Note: The creation of an ADK archive stock with object YY_YR_yyyy is 
separate from the archiving process for the archiving object FI_DOCUMNT. 
YY_YR_yyyy does not archive or delete database documents.

Use YEAM > Transaction data > Save to create the transaction data 
stock at the end of the fiscal year, as shown in Figure 36.

Figure 36 Selection screen to save transaction data

Note: A fiscal year stock can only be created if the posting periods of the 
fiscal year are marked closed.

Multiple stocks can be created for a fiscal year if each extract stock is 
given a unique name for reporting purposes.

Run the Fiscal Year Recorder in the background unless the run is for 
testing purposes.
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At the end of each extract run, the delimitations and the 
reconciliation results are printed in detail, as shown in Figure 37.

Figure 37 Reconciliation results for saved transaction data

Use YEAM > Transaction data > Delete to delete erroneous extract 
stock.

Note: If transaction data is deleted after conversion from local currency to 
Euro, data is lost.
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Extract master data at fiscal year closing
Master data, such as customers, vendors, and GA/L account 
information, can also be extracted with transaction data using YEAM 
> Master data > Save, as shown in Figure 38.

Figure 38 Selection screen to save master data

Master data is stored in compressed form in the cluster file YVKZ (or 
/PBS/YVKZ for version 4.x and later). Make the first data backup 
covering several fiscal years. Subsequent data backups should be 
done after the closing of each fiscal year.

Yearly backups result in a long term archive. Use Validation to check 
if selected company codes and fiscal years are valid.

Fiscal years can only be saved once unless the existing fiscal year is 
deleted from the backup file YVKZ (or /PBS/YVKZ for version 4.x 
and later).

Note: If transaction data is deleted after conversion from local currency to 
Euro data is lost.

Run the Fiscal Year Recorder in the background unless the run is for 
testing purposes.

Table 10, Table 11 on page 68, Table 12 on page 68, and Table 13 on 
page 69 list the backup tables created.

Table 10 Customers

Table name Description

KNA1 Customer master general

KNAS EC taxes

KNKA Credit limit
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KNBK Customer master bank data

KNB1 Customer master company code

KNB4 Behavior in payment

KNB5 Dunning data

KNKK Credit control area

KNC1 Customers monthly debits and credits

KNC3 Customers special general ledger monthly debits and credits

Table 11 Vendors

Table name Description

LFA1 Vendor master general

LFAS EC taxes

LFB1 Vendor master company code

LFBK Vendor master bank data

LFB5 Dunning data

LFC1 Vendor monthly debits and credits

LFC3 Vendor special general ledger monthly debits and credits 

Table 12 G/L accounts

Table name Description

SKA1 G/L account master general

SKB1 G/L account master company code

SKAT G/L account master name

GLT0 G/L accounts monthly debits and credits

Table 10 Customers (continued)

Table name Description
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At the end of the backup process a detailed selection statistic is 
displayed, as shown in Figure 39.

Figure 39 Selection result for saved master data

Table 13 Miscellaneous

Table name Description

T001 Company code table
Extract master data at fiscal year closing 69
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Fiscal Year Reporting
Direct accesses to saved master data in logical databases can be done 
as follows:

◆ vendors = YKF

◆ customers = YDF

◆ G/L accounts = YSF

ViewPoint for SAP predefined fiscal year closing programs are called 
using transaction YEAR > Reporting, as shown in Figure 40.

Figure 40 Fiscal Year Reporting selection screen

The balance audit trail programs YYHABU01 and YYKKBU01, 
available up to release 4.6, have an improved sort technique.

Note: Programs YYKKBU01 and YYHABU01 use the same temporary sort 
path. Do not run them simultaneously as background processes.
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Fiscal Year Reporter audit access
ViewPoint for SAP FYR provides the following audit access types.

Access 1 (Z1) indirect data access —  Allows a tax authority 
read-only access to stored data for the audit period, including the 
master data and links (data), excluding remote queries (online 
access). The read-only access covers reading, filtering and sorting 
data using the evaluation functionality of the data processing system.

Access 2 (Z2) direct data access —  Allows the tax authority to 
request the taxpayer or a third party to execute read-only access 
(indirect access) and evaluate the data using the evaluation 
functionality of the data processing system.

Access 3 (Z3) data by transferring data on data carriers —  Allows 
the tax authority to request a data extract of business records which is 
returned to the taxpayer, or deleted, after the external audit is 
complete. Access is limited to data for financial accounting, asset 
accounting, and payroll accounting.

Relevant data in other areas of the data processing system is qualified 
by the taxpayer for sales, purchase order, material, and invoice 
verification documents.

Audit access 
strategies

R/3 audit requirements are met using Z1 and Z2 access. To support 
Z3 audit access (data extraction) use DART (Data Retention Tool) 
explained in Chapter 7, ”Data Retention Tool”.
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Table 14 lists details for each audit access strategy. 

Access types Z1 
and Z2

Delimit the selection for each field from the document header (table 
BKPF), the document item (table BSEG) and the tax line (table BSET). 
For a tax check, the documents to be checked can be selected and 
evaluated, as shown in Figure 41.

Figure 41 Access types Z1 and Z2 delimitations

Table 14 ViewPoint for SAP access types

Access type ViewPoint for SAP module support Features

Z1 Modules CCO, CCU, CFI, CHR, CMM, CMT, CPCA, CPM, 
CPP, CPR, CSD, CSL, CWM

Data access to archive and DB
Dialog transactions
FI standard reporting
Customer-specific reporting
ViewPoint long term archiving concept

Z2 Fiscal Year Reporter Data access to archive and DB DB
Dialog transactions
FI standard reporting
Customer-specific reporting
ViewPoint long term archiving concept

Z3 ViewPoint for SAP CDART
CFI Module and Fiscal Year Reporter

DART extracts from archive and DB
ADK files without DB reloading process
Data export via variable ABAP extract
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Data format Table 15 lists the SAP AIS format structure.

Safety After the export the data leaves the SAP environment and SAP 
authorization no longer works:

◆ In the file system of the target computer (c:\...)

◆ In the file system of the application server (d:\usr\sap\...)

Protect exported data against unauthorized access.

Table 15 SAP AIS format

Line type Number Characteristic value

Header 1 Field name

2 Description

3 Field description

4 Data type (C,N,P,I,D,T,F)
C = text, N = numeric text on the left filled with zero, P = packed (number digits = field length * 2 
- 1) This is the SAP internal type. The format [-]digits[,|.digits] is used in the data records. 
Example: Type P length 7 decimal places 2 leads to the output -12345678901.23, I = integer, D 
= date with format DD.MM.YYYY, T = time with format HH:MM:SS, F = floating point number.

5 Field length

6 Number decimal places

7 Currency code or quantity indicator (F,W,M,E)
A currency unit field always comes after a currency field. A unit of measure field always comes 
after a quantity field.
F = currency, W = currency unit, M = quantity, E = unit of measure

8 Special field types (R,C,P,M)
R = rank (statistics), C = counter (statistics), P = percentage (statistics), M = mean value 
(statistics)

Data line 9 Data records
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Export programs Table 16 lists those programs which support the export of data from 
the SAP system using ViewPoint for SAP FYR. Asset accounting data 
is not selected with the ViewPoint for SAP archive but using SAP.

Table 16 Export programs

Program name /PBS/FYR_LIS Description Variable Logical Database Table F a Description

ITEM item list /PBS/YBF BKPF _K document header

BSEG _G document item

BSET _T tax line

BSED _D bill of exchange line

BSEC _C CPD line

ITEM_ASSET asset item list ADA ANEK _K document header

ANEPV document item

VENDOR vendor list /PBS/YKF LFA1 _A vendor master in general

master data LFAS _T EU taxes

LFB1 _B vendor master company code

LFB5 _M reminder data

LFC1 _1 transaction figures

LFC3 _3 special general ledger 
transactions

CUSTOMER customer list /PBS/YDF KNA1 _A customer master in general

master data KNAS _T EU taxes

KNKA _L credit limit

KNB1 _B customer master company 
code

KNB4 _Z payment history

KNB5 _M reminder data

KNC1 _1 transaction figures

KNC3 _3 special general ledger 
transactions
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The reports can be generated using Fiscal Year Reporter > Reporting 
> Data export, as shown in Figure 42.

Figure 42 Fiscal Year Reporter data export menu

GLACC G/L account list /PBS/YSF SKA1 _A G/L account master in 
general

master data SKB1 _B G/L account master company 
code 

SKAT _T G/L account text

SKC1A _1 transaction figures local 
currency 

SKC1C _3 transaction figures foreign 
currency

ASSET asset list ADA ANLAV _A asset in general

master data ANLV _V insurance data

ANLZ _Z value-dated asset 
assignments 

ANLB _B depreciation parameter

ANLCV _C assets value fields

REFERENCE general table contents

a. Field extension indicator

Table 16 Export programs (continued)

Program name /PBS/FYR_LIS Description Variable Logical Database Table F a Description
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Note: For SAP releases 4.0 and 4.5, generate the export structures using 
/PBS/FYR_LIS_GENERATE each time the database tables change.

Export selection 
screen

The export selection screen for export programs consists of three 
parts:

◆ “Delimitations to influence the scope of selection”

◆ “Selection of list layouts”

◆ “Output option” on page 77

Delimitations to
influence the scope of

selection

Delimits the logical database selection for each report.

Selection of list layouts Contains all fields displayed from the selected data volume. Defined 
with SAP-ALV (ABAP-List-Viewer) within an export program and 
stored under an own name, several list variants are possible per 
export program in order to meet different requirements, as shown in 
Figure 43.

Figure 43 List layout selection screen

Follow this procedure to create a list for an export program.

1. Click Display/Print to generate the desired report.

Keep the selected data volume small for performance reasons.

2. Select Options > Layout > change to define the scope of the list.

3. Select Options > Layout > store to store the list variant.

Note: Select Options > Layout > Layout administration > Layout > 
Transport to transfer the list from a test system into the production 
system.
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Output option Use the selection screen to display the dataset as an ALV list or to 
transfer the list to an export directory, as shown in Figure 44.

Figure 44 Output option

Note: Process large selection volumes in the background.

Before the data export executes the system checks whether:

◆ The indicated directory exists and can be written to

◆ The indicated file name already exists.

If the file already exists, choose whether to overwrite the existing 
file, or select another file name.

At the end of each export transaction an export statistic is exported 
and displayed, as shown in Figure 45.

Figure 45 Export statistic

Export file size The size of an export file depends on the number of items selected 
and the number of criteria on the selection list, which displays the list 
layout changes. Determine disk space as follows:

(number items x line width of the layout)
+  2000 bytes header record SAP-AIS

Authorization 
concept

Authorization is required:

◆ To execute reports
Fiscal Year Reporter audit access 77



78

Fiscal Year Reporter
◆ Use the ViewPoint menu for transactions beginning with 
/PBS/YR

◆ View accounts, company code, business areas, etc.

◆ Use transaction SE16 (Display table contents)

Transfer files to PC When extract stock is creation is complete, files can be transferred 
from the UNIX or Windows NT server to a PC using ASCII mode (ftp 
> bin).

Using PC analysis 
programs

Extract stocks can be processed by indicating a file format in an 
analysis program such as IEDA, as shown in Figure 46.

Figure 46 File format definition using IDEA

Use a PC analysis program to check the extracted data factual 
consistency, as shown in Figure 47.

Figure 47 Data display in IDEA
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Extracting data The following ViewPoint for SAP reports can help meet legal 
requirements for extracted data. The default ViewPoint for SAP 
selection can be extended if required. The overview of the export 
programs lists the database tables from which the data can be 
extracted.

Financial accounting T003—Document type

T003T—Document type name

T007A—Tax key

T007S—Tax code name 

T001—Company code 

TGSBT—Business area name

TBSL—Posting key

TBSLT—Posting key name

Asset accounting TABW—Transaction types of the asset accounting

TABWA—Transaction types / Depreciation areas

TABWG—Transaction types groups

TABWH—Name asset transaction type groups

TABWK—AM transaction types for posting of proportional values 
and depreciation

TABWR—Name of asset history sheet group

TABWT—Transaction type texts of asset accounting

TABWU—special treatment of retirement

TAPRFT—Text table for investment profile 

TAPRF—Investment measure profile for asset under                                          
construction and depreciation simulation

Use the ViewPoint for SAP menu General table data to access these 
tables.
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Generate the export program using Export of general table data by 
indicating the table name, as shown in Figure 48.

Figure 48 Generate table export

Create the layout list for export, as shown in Figure 49.

Figure 49 Generate table extract
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ALV layout definitions Right-click technical field names to switch between the field name 
and technical field name if selection fields display several times when 
defining a list layout.

Single line lists When using one list variant for the data export, only a single line is 
listed.

File path default Define a default value in the user master for the file path with the 
parameter ID > /PBS/FYR_LIS_PATH.

Data export
terminates

The data export terminates with the message Variant was not found 
if the layout in which the fields to be extracted were not defined, do 
not exist, or were not stored when the layout was created.

PC analysis program
terminates

PC analysis programs terminate with the message SAP/AIS file is 
invalid during the transfer of export files from UNIX/Windows NT 
to PC if the transfer was executed in BINARY instead of ASCII mode.

List output contains
wildcard characters

For SAP version 4.0/4.5, regenerate the export structures with the 
program /PBS/FYR_LIS_GENERATE to eliminate wildcard 
characters if the export structures do not fit to the data table 
structures.
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Administration
Use the menu transaction YEAM or YEAR for administrative tasks.

Note: These tasks should be available to administrative personnel only.

Table 17 lists the transactions to add to the user profile for the user 
department and the administrator.

The transaction YEAM should be made available to administrators 
only to modify data material.

To delete master data use transaction S_ARCHIVE-authorization for 
object FI_DOCUMNT with 01= create.

Delete transaction 
data

Use Delete transaction data to delete fiscal year ADK files and all 
corresponding administration entries. Single stocks can be deleted if 
several stocks exist for a fiscal year because of splitting by company 
code.

Delete master data Use Delete master data to delete fiscal year and company code 
compressed master data from the table YVKZ (for SAP version 4.x 
/PBS/YVKZ).

Activate reporting Use Activate reporting to copy SAP programs using logical database 
BRF to the Fiscal Year Reporter database YBF.

Balance audit trail 
cancelled during 
processing

Use Balance audit trail > Delete sortfile to delete the sortfiles created 
in the temporary sort directory if the balance audit trail tools 
YYHABU01 or YYKKBU01 are cancelled during processing. This 
re-initializes the path for the temporary sortfiles.

Table 17 YEAR

Release Administrator User department

3.x Y* YEAR, YR02,YR06,YR07, YR11

4.x /PBS/Y* /PBS/YEAR, /PBS/YR02, /PBS/YR06, /PBS/YR07, /PBS/YR11
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Master data For each fiscal year a Master data list appears, showing those 
company codes for which a data backup has been carried out using 
Fiscal Year Reporter.

Transaction data For each fiscal year a Transaction data list appears, showing which 
backup runs have completed. A fiscal year is listed several times if a 
backup was run for each company code. Click Protocol to display all 
delimitations used for the backup run.

Logical database Choose one of these logical databases to access the data stock of the 
Fiscal Year Reporter.

SAPDBYBF document
database

SAPDBYBF reads sequential versions of saved Fiscal Year Reporter 
documents and master data. To use an own program to select the 
transactions of a fiscal year according to the posting period and all 
items cleared in this fiscal year, change the logical database from BRF 
to YBF. Add to the own program the following statement after 
START-OF-SELECTION to deactivate the check on the posting period 
in the logical database:

GJ_ONLY = space

ViewPoint for SAP reads sequential versions of master data similar to 
SAP.

SAPDBYDF customer
database

Use this database to process only master data with no documents 
selected as there is no secondary index link between the customer 
and the ADK file YY_YR_yyyy. This database does not correspond to 
the SAP standard database DDF because customer master data of 
Fiscal Year Reporter only is processed.

ViewPoint for SAP
Fiscal Year Reporter

database

Use this database to process only master data with no documents 
selected as there is no secondary index link between the vendor and 
the ADK file YY_YR_yyyy. This database does not correspond to the 
SAP standard database KDF as only the vendor master data of the 
Fiscal Year Reporter are processed.

SAPDBYSF G/L
accounts database

Use this database to process only master data with no documents 
selected as there is no secondary index link between G/L and the 
ADK file YY_YR_yyyy. This database does not correspond to the SAP 
standard database SDF, as only the G/L account master data of the 
Fiscal Year Reporter is processed.
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Master data direct 
access

Use transaction YEAR/YEAM > Tools > Tutorial > Read master data 
to start the tool YYCFVKZ4 (version 4.x /PBS/YYCFVKZ4) to 
directly access Fiscal Year Reporter master data.

Alternately, use an external call to program YYCFVKZ3 (version 4.x 
/PBS/YYCFVKZ3) to directly access Fiscal Year Reporter master 
data.

Change extract 
stock description

Use transaction SARA to display the created backup stock after 
entering the archiving object YY_YR_yyyy (yyyy = fiscal year). 
Double-click the management line to change the description of the 
extract stock with function key F5.

Display 
reconciliation 
differences

Use transaction YEAR/YEAM > Transaction data > Manage to 
display the run protocol stored in a management table for each 
extract run of the Fiscal Year Reporter. Select a management line and 
press F5. The last line in an entry shows if there were differences in 
the reconciliation.

Clear archive file 
name

If logical file names are not clear, existing archive stocks of the Fiscal 
Year Reporter are overtyped. Create clear names by entering the 
variable <TIME> into the file name. For example, use the definition of 
the logical file name ARCHIVE_DATA_FILE1.

A logical file name exists for each fiscal year archiving object 
yy_yr_xxxx (where xxxx = fiscal year). View this logical file name 
with transaction SARA or AOBJ. Use transaction File > Definition 
logical file name independent of client to view how the logical file 
name is composed.

Note: Be sure to update previously created stocks while changing 
logical/physical file names.

Manually create an 
archiving object

Use program YYCFOBJC (version 4.0 /PBS/YYCFOBJC) to manually 
create an archiving object without having to wait until the archiving 
object is automatically created after transaction data is stored for one 
fiscal year.
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Overview
The SAP Data Retention Tool (DART), or SAP Z3 scenario, facilitates 
compliance with tax authority requests for data extraction of business 
records.

SAP DART data flow The SAP DART is an alternative solution to SAP BW, SAP queries, 
and ABAP reports in the SAP environment following the SAP DART 
data flow, as shown in Figure 50.

Figure 50 SAP DART data flow

SAP DART is included in the SAP standard installation and enables 
data extraction from a predefined volume. That data is then stored in 
external data media or on a file server for compliance purposes. Data 
views can be made available to the tax authority in the event of an 
audit.

ViewPoint for SAP
CDART data flow

The ViewPoint for SAP CDART module extends the SAP DART 
functionality so that the SAP ADK files DART extract runs are 
integrated, avoiding temporary reloading of archive data into the 
database. The data access is executed through indices generated with 
the CDART Tool.

Database performance improves since permanent storage capacity is 
not provided for extract stocks until they are used.
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The stocks are created on demand, following the ViewPoint for SAP 
CDART module data flow, as shown in Figure 51.

Figure 51 ViewPoint for SAP CDART module data flow

CDART transaction 
data

Table 18 gives an overview of transaction data affected by archiving 
and extracted from the archive using CDART. All other segments 
have master data, transaction figures, or are not affected by archiving.

Table 18 CDART transaction data

Original Segment structure DART Description

ANEK TXW_AD_HD Asset document header

ANEP TXW_AD_POS Asset document item

AFRU TXW_AFRU Order confirmation

AFVC TXW_AFVC Order operation

ANLE TXW_ANLE Asset origin from line items

ANLK TXW_ANLK Asset origin from cost element

ANLP TXW_ANLP Asset periodic sizes

ANEA TXW_ANEA Shared values of attachment 
document 

Items

VBRK TXW_BI_HD Billing document header
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VBRP TXW_BI_POS Billing document item

BSET TXW_BSET Document segment tax data

KONV TXW_CONDPR Pricing conditions (billing documents)

COSP TXW_CO_COST_TOTALS Controlling object: total cost

COSS TXW_CO_COST_TOTOLS Controlling object: total cost

COBK TXW_CO_HD CO document header

COEP TXW_CO_POS CO document item

COBK TXW_CO_SHD CO document header 

Secondary posting

COEP TXW_CO_SPOS CO document item

Secondary posting

LIKP TXW_DL_HD Delivery document header

LIPS TXW_DL_POS Delivery document item

EIKP TXW_EIKP Export/Import header data

EIPO TXW_EIPO Export/Import item data

BKPF TXW_FI_HD FI document header

BSIK TXW_FI_OP Open item FI

BSIS TXW_FI_OP Open item FI

BSID TXW_FI_OP Open item FI

BSEG TXW_FI_POS FI document item

MKPF TXW_MM_HD MM document header

EKKO TXW_MM_POH MM order header

EKPO TXW_MM_POP MM purchase order item

MSEG TXW_MM_POS MM document item

COFIS TXW_RC_POS FI/CO settlement item

Table 18 CDART transaction data (continued)

Original Segment structure DART Description
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VBAK TXW_SD_HD Sales document header

VBAP TXW_SD_POS Sales document item

VBPA TXW_SD_PRT SD Partner

VBKD TXW_VBKD Sales document: sales data

Table 18 CDART transaction data (continued)

Original Segment structure DART Description
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Using CDART
ViewPoint for SAP CDART module provides the necessary 
definitions to archive data.

Creating the CDART 
Easy Access menu

Follow this procedure to create an SAP Easy Access menu for 
CDART.

1. From the ViewPoint for SAP CDART module area menu 
/PBS/DART generate:

• an activity group (4.6B)

• a role (4.6C)

as shown in Figure 52.

Figure 52 Create a role

2. Choose the name of the activity group or role from within the 
ViewPoint namespace. For example:

/PBS/DART

3. Click Transfer menus from area menus to transfer the ViewPoint 
for SAP CDART module range menu.

4. Indicate the corresponding ViewPoint for SAP menu name. For 
example:

/PBS/DART

5. Click Yes to the system query for the resolution of the range 
menu.

6. Integrate the role/activity group into the user master (transaction 
SU01).
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The Easy Access menu displays within the user menu, as shown 
in Figure 53.

Figure 53 Role /PBS/DART 

The CDART menu is essentially the same as the SAP DART menu, as 
shown in Figure 54. The ViewPoint for SAP specific transactions are 
Extract data, Generate index archive data, and Check FI control 
totals. All other menu options call the original SAP DART programs.

Figure 54 CDART menu
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Customer-specific 
fields

The list of extraction fields is user-definable and is updated in the 
data dictionary. SAP original type extraction fields automatically 
transfer to the ViewPoint for SAP CDART module. Other fields, such 
as amounts, are transferred using 
/PBS/DART_EXIT_SAPLTXW2_001 and 
/PBS/DART_EXIT_SAPLTXW2_002.

All customer modifications in SAP DART can be transferred to 
ViewPoint for SAP. Update customer modifications when updating 
ViewPoint for SAP, if necessary.

Data source Use the menu option generate index archive data > customizing - 
data source to set the archive data imported using the existing 
ViewPoint for SAP modules or using the CDART archive indices, as 
shown in Figure 55.

Figure 55 CDART data source selection

Table 19 lists the module indices that can be used with CDART to 
extract document types.

Table 19 CDART extracted document types

Module Module name Type

CFI Financial accounting documents FI_DOCUMNT

CFI Material documents MM_MATBEL

CSD Sales documents SD_VBAK

CSD Deliveries RV_LIKP

CSD Billing documents SD_VBRK

CMM Orders MM_EKKO
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Indices must be built directly in the CDART to extract other 
document types.

Note: Indices for all archiving objects must be built in CDART to extract other 
document types, such as CO cost totals.

Archiving object 
/PBS/DART

Indices are stored through the archiving object /PBS/DART. 
Transaction SARA assigns a logical file name with Customizing > 
archiving object specific customizing. ARCHIVE_DATA_FILE is set 
during the ViewPoint installation, the value for which must be 
changed so that the path is created in the file system and read/write 
authorization exists at the operating system level.
Using CDART 93



94

Data Retention Tool
Archiving ViewPoint for SAP modules data
An index must be created for each ViewPoint for SAP module used 
before executing the CDART extraction. This index points to the 
location of the archive data.

Follow this procedure to generate the module index for CDART.

1. Start the index generation using:

menu option Utilities > Generate index archive data, or

transaction /PBS/DART_SETUP.

The index generation menu displays, as shown in Figure 56.

Figure 56 Index generation menu

The indices are stored in the archiving object /PBS/DART.

Note: The path assigned to the archiving object must be stored in the file 
system and there must be enough disk space to write the indices to disk, 
as described in “Archiving object /PBS/DART” on page 93.

Each indexed SAP ADK file requires an additional 5 percent of disk space 
more than needed by the physical ADK file.

2. Select menu option Index > Index Generation.
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The Index Construction screen appears, as shown in Figure 57.

Figure 57 Index Construction screen

Table 20 lists the traffic light definitions that help determine 
whether it is necessary to generate indices for each corresponding 
archiving object.

3. Click on a line with a yellow status.

Table 20 Traffic light status definitions

Color Definition

Red The archiving object is not archived.

Yellow Index generation is incomplete and must be generated for objects.

Green All existing archive data is indexed.
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The index generation screen displays so the missing index 
generation can be completed resulting in the color definition 
changing to green.

Note: CDART data extraction should only be carried out when all traffic 
lights are green or red.

4. Click the i function key for additional index information.

A popup displays the table fields for that archiving object.

5. Use transaction SE16 and enter the table /PBS/DART_INDEX to 
display all available indices.

Manual entry
Use the menu item Utilities > generate index directly to manually 
enter the archiving object.
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The manual index construction screen displays, as shown in 
Figure 58, without the traffic lights to show indices status.

Figure 58 Manual index construction screen

Select archive —  Allows manual selection of archiving runs created 
with transaction SARA for SAP archive objects. Click SAP to archive 
the corresponding SAP archiving runs displayed, which were created 
from the entered date.
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Selecting the requested SAP archiving runs allows the system to 
check if the run was loaded into the ViewPoint for SAP archive, as 
shown in Figure 59.

Figure 59 System messages

Load automatically from —  Processes all documents from the 
selected date without individually selecting each SAP archive. SAP 
archives already completed are not indexed to the ViewPoint for SAP 
archive a second time. This function automates the load runs and can 
be scheduled as a background job by using a selection variant.

Delete old run  —  Select Run to display a list of previous load runs 
for selection and deletion, or delete all SAP archiving runs for the 
selected ViewPoint for SAP module.

Process all documents —  Selecting ensures that all documents in the 
SAP archiving run are indexed.

Process sequential number range —  Specify the range of 
documents to be processed. Executing several runs with a limited 
number of documents allows for best processing time and job 
handling.

Note: For SAP release 4.6 and prior, extend the paging area in the system 
profile for the sorting of indexes if the process run terminates with the error 
message SYSTEM_NO_MORE_PAGING.
For SAP releases after 4.6, a directory is assigned for sorting with the system 
parameter DIR_SORTTMP that can be extended in a 32-bit operating system 
to avoid any sorting problems.
Archives already processed are neither automatically recognized nor is a 
check carried out if intervals overlap.
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Merge —  In CDART the index is kept in ADK files, which requires a 
new ADK number for each run of the index generation program. 
New archive is active for each new index compilation and Merge 
with archive is active, with the previous ADK run number, for the 
subsequent merge, as shown in Figure 60.

Figure 60 Above: Before the 1st run; Below: Proposal for merge run

To reduce runtimes use new archive to create a second index stock 
that is not merged with the first. The CDART reading routines read 
several index stocks in parallel. For example, start a new index stock 
once a year.

Postprocessing 
programs

The index generation program starts two post-processing programs, 
both of which can be started manually from the Utilities menu.

Create management indices —  Writes control records into the 
database needed for generated indices access.

Delete previous run —  Deletes ADK files not containing current 
index sets.

Archive tool Use Utilities > Archive Tool to view the index after the index 
generation run with its post-processing programs completes.
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The data is now available for CDART extraction, as shown in 
Figure 61.

Figure 61 Archive tool selection screen.

Index Number —  Choose the index. Press F4 to get the index 
number description.

Index list —  Choose the desired index from a list.

Job protocols —  Displays the job logs.

Start at key —  Enter the index key to start from higher index 
numbers.

Deletion tool Use Utilities > Delete index to delete index records, as shown in 
Figure 62.

Figure 62 Deletion tool selection screen

Keep only the most current run —  Select to delete all runs selected 
with Run. This is automatic if during index generation 
post-processing Delete initial run was activated.
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Delete archive via selection list —  Select to display an overview of 
all generated index runs and delete load runs from this list. This is 
useful when recreating indices.

Note: Index records are physically deleted. Once deleted, generation runs for 
the archiving object must be repeated.

Extract

Disk space
requirement

The extraction program executes only one archive access for each 
document for performance reasons, temporarily storing additional 
tables for later processing and deletion. The DART path, used in the 
extraction program, has to have enough disk space.

Disk space size can be determined using the ViewPoint for SAP 
Configuration > File size worksheet. Since disk space for temporary 
files has to be added during the extraction from the archive, take 
twice the value defined using the worksheet to provide for the 
generation of the extract stock. The full capacity is not required, but 
represents an upper limit.

DART version The ViewPoint for SAP CDART module version must match the SAP 
DART version or there might be dictionary objects missing.

Use transaction SE11 to verify the SAP DART version.

Settings Use settings for data extracts to set extract setting such as file name, 
file size, and document types taken into account during the extract. 
Document types are displayed for selection in the extract program 
after settings are selected.

For CDART use transaction data > additional transaction data > 
data reloaded from archives to set extract archive data via 
ViewPoint.

Create an extract After all DART definitions are complete, the extracts can be created 
using Utilities > Extract data. Select Extract archive data via 
ViewPoint to automatically select the archive data in the index of 
ViewPoint for SAP module, and transfer it to the extract stock.
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Further processing of
the extract

Use Information system to start the DART extract browser to view 
and check extracted data, as shown in Figure 63.

Figure 63 Data extract browser

Export view data from the extracts for auditing using Z3 access.

To evaluate CDART extracts outside the SAP system on a PC, refer to 
the ViewPoint for SAP IDA module (Independent DART Access), a 
separate module.
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Overview
Use ViewPoint for SAP Database Analyzer Plus to examine an SAP 
R/3 system to determine:

◆ How much disk space is occupied by each module

◆ Which module requires the most disk space

◆ How much the SAP R/3 database increases monthly and yearly

◆ Size of the financial accounting monthly document volume

◆ Those archiving objects for which archiving is useful

◆ Average size of a purchasing document

◆ What table is archived with what archiving object

◆ What ViewPoint for SAP archiving modules are needed

Database Analyzer Plus consists of three essential functions:

◆ Analyze the capacity occupied by database tables

◆ Analyze the distribution of documents for selected SAP modules

◆ Execute an archiving check for selected SAP modules

Capacity analysis The capacity analysis executes an analysis of the tables used by the 
archiving objects and stores the results for evaluation in the database. 
Optionally, a detailed analysis of CO tables, such as COEP, COSS, and 
COSP can be done, depending on if archiving was done with or 
without the archiving object CO_ITEM. If CO_ITEM was used for 
archiving, a detailed evaluation is not necessary since the 
corresponding tables are included in this object.

The ViewPoint for SAP module for each archiving object checked can 
be displayed in the evaluation, revealing which ViewPoint for SAP 
modules are relevant.

Single tables can be added for analysis during the next capacity run. 
The results are displayed separately in the analysis and the archiving 
objects belonging to that table can be displayed.

Document 
distribution analysis

Document distribution analysis provides information on the 
temporal distribution of the entered documents defined by any 
selection and grouping criteria. The client and period are available as 
grouping criteria with other module-dependent features available, 
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such as company code and document type in the ViewPoint for SAP 
FI module.

A distribution analysis assigns documents, according to the time they 
were entered, by determining the number of existing documents by 
period. Combined with the archiving check, the distribution analysis 
also ensures successful archiving for selected SAP modules.

Archiving check The archiving check determines if documents can be archived. After 
the document distribution analysis check documents of a certain 
period, the archiving check examines existing documents for 
archivability or displays the reason the document is not ready for 
archive. This analysis is also available for selected SAP modules.
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Capacity analysis
Table 21 lists the two ABAP/4 programs used to perform the capacity 
analysis of archiving objects.

Initialization Before starting the first capacity analysis the ViewPoint for SAP 
Database Analyzer Plus database tables must be reconstructed in the 
SAP R/3 system by starting the ABAP /PBS/ANA_ERSTAUFBAU 
by copying the entries of the database table /PBS/ANA_AR_DEF 
into the table /PBS/ANA_AR_OBJ, and supplementing it with the 
table names of the SQL database.

ABAP /PBS/ANA_ERSTAUFBAU is also used to delete all existing 
analyses.

Before starting an analysis for an AS/400 database, refer to “AS/400 
database” on page 108.

Capacity analysis Use this procedure to run the capacity analysis.

1. Start the ABAP /PBS/ANA_AUFBAU.

Note: Run the ABAP /PBS/ANA_ AUFBAU as a background process 
checking the progress of the run with the protocol entries of the own jobs.

Depending on the database system, ABAP /PBS/ANA_AUFBAU 
starts a corresponding ABAP for the construction of the capacity 
analysis.

Table 21 Capacity analysis ABAP/4 programs

ABAP/4 program Description

/PBS/ANA_AUFBAU Starts the analysis and stores the results in the 
database table /PBS/ANA_AR_LFN. Within the 
capacity run the disk space occupancy of the tables 
allocated to the archiving objects is determined.

/PBS/ANA_KAPAZITAET Evaluates and displays the results by archiving 
object.
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For example, in an ORACLE database system, the ABAP 
/PBS/ANA_ORACLE starts, as shown in Figure 64.

Figure 64 Selection mask for Oracle capacity construction

2. Enter information for the following fields.

Description capacity run —  Descriptive title for the analysis run.

Use analysis from SAPDBA —  Option for Oracle database system. 
Details can be found in “Oracle database” on page 108.

Create new analysis —  Option for Oracle database system. Details 
can be found in “Oracle database” on page 108.

Detailed analysis of CO records —  Carries out an exact analysis of 
the CO records when allocating CO tables, such as COEP and COSS, 
to the corresponding archiving objects. Requires a long run time. Not 
needed with archiving object CO_ITEM. If unselected, the 
corresponding CO tables are distributed to the archiving objects 
CO_COSTCTR and CO_ORDER.

Secured run —  In a production system, prevents an ABAP from 
getting into an endless loop when a SELECT-COUNT command to a 
cluster table (CDCLS) is carried out. The database tables for the 
document changes (CDHDR and CDPOS) are not split and appear in 
the evaluation with the size 0. If unselected, after several hours the 
ABAP will eventually cancel with the error message SQL error 1555 at 
access ... 

Single table analysis —  Activates the analysis of single tables as 
described in “Single table analysis” on page 108. The data is stored in 
the database tables /PBS/ANA_AR_LFN and /PBS/ANA_AR_TXT 
under a sequential number (run no.) and can be evaluated with the 
program /PBS/ANA_KAPAZITAET described in “Single table 
analysis” on page 108).
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Oracle database From SAP release 4.0, choose one of the following:

Use analysis from SAPDBA —  The size of the database table is 
taken from the last analysis run with SAPDBA.

Create analysis again —  The size of the database tables is 
determined again. Tables marked in the system table DBSTATC 
(trans. DB21) in field Active with "R" or "N" cannot be analyzed. 
These tables are displayed in the job protocol during the analysis 
construction. To integrate these tables in the analysis, the value 
entered in field KAP_MAX is used in table /PBS/ANA_AR_OBJ.

Informix database In an Informix database, it is not possible to determine the exact 
tables size as the fill level of the different pages is not known. Two 
different types of analysis are offered:

Number of lines * line size —  Provides nearly exact table size 
without compression.

Used pages —  Indicates the size of pages used of each table on the 
database server.

AS/400 database Before starting the analysis in an AS/400 environment with the 
ABAP /PBS/ANA_AS400 the database table DBSTATTDB4 must be 
updated with transaction DB02 and the initialization started with 
"Refresh data" (update data statistic).

Note: An SAP correction order must be imported if the program cancels.

Correction of 
capacity 
commitment (SAP 
4.0)

Program /PBS/ANA_RARCCOA1 corrects the distribution of CO 
records, when an analysis is constructed by SAP program 
RARCCOA1, and stores the result under the next higher run number 
allowing determination of the description of the run.

Single table analysis The single table analysis enables you to analyze tables independent 
from an archiving object when updating table /PBS/ANA_TAB_DEF 
with transaction SE11.
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Enter the name of the table in field TABLENAME, leaving field 
SQLTAB empty, as shown in Figure 65.

Figure 65 Update of table with transaction SE11

Execute a new initialization with ABAP /PBS/ANA_ERSTAUFBAU. 
Selecting ...and keep previous analyses keeps the previous analysis.

During the next capacity run, the implemented tables are also 
analyzed, as shown in Figure 66.

Figure 66 Implementation table analysis
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Database analysis 
evaluation

Evaluate an analysis run with the ABAP /PBS/ANA_KAPAZITAET. 
The database analysis for archiving object FI_DOCUMNT is shown in 
Figure 67.

Figure 67 Evaluation screen

Selections Enter data selection criteria and output layout in the Selections area 
of the Evaluation screen.

Application —  Enter the application name(s), such as SD, FI, MM, 
PP.

Archiving object —  Enter the archiving object name(s), such as 
MM_EKKO, FI_DOCUMNT, RV_LIKP.

Database table —  Enter the database table name(s), such as EKKO, 
BKPF, VBRK, LIKP.

Run number —  Enter the run number.

Options Enter selections in the Options section of the Evaluation screen.

Group by —  Select to create a list grouped by Archiving object or 
Database table.
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Sort —  Select to sort the grouping by Size or Name.

Archiving with CO_ITEM —  Determines if archiving object 
CO_ITEM is included in the analysis if the capacity analysis was 
started with the option Detailed analysis of the CO records 
explained on page 107. Left unselected, the CO tables of archiving 
object CO_ITEM are distributed to the corresponding archiving 
objects, especially when using the ViewPoint for SAP CCO module. 

Determine document size —  Determines the average size for certain 
documents.

Show zero values —  Select to display zero values.

Show database tables —  Select to display details of database tables.

Single table evaluation —  Displays the capacity of single tables.

Show VPT module —  Select to display the ViewPoint for SAP 
module.

Download results —  Download the results locally.

The result after the selection of program /PBS/ANA_KAPAZITAET 
appear, as shown in Figure 68.

Figure 68 Result of the capacity analysis
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Analysis details appear at the top of the screen, as shown in 
Figure 69.

Figure 69 Capacity run details

The disk occupancies values originated from capacity run 0002 from 
29.03.2000 created with program /PBS/ANA_AUFBAU with a total 
capacity of 3,097,306 KB and stored under the description Capacity 
analysis ID4 with CO details.

The evaluation of the analysis started on 07.04.2000 at 14:57:15 by 
user DOERRSCHUCK, as shown in Figure 70.

Figure 70 Analysis evaluation

A total of 452,126 KB was selected, which is 15% of the total capacity 
of 3,097,306 KB of run 0001, as shown in Figure 71.

Figure 71 Evaluation

Archiving object FI_DOCUMNT has a total of 71,476 documents 
(entries in table BKPF) with a total size of 148,095 KB in the system. 
The size of a document is 2,122 bytes. The archiving object has a 100% 
portion in the selection and a 9% portion in the total capacity. 
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The size of table BSEG is 61,631 KB, which is 41.6% of the selected 
data and 3.7% of the total capacity, as shown in Figure 72.

Figure 72 Object archiving

Note: If the size of a table is displayed in brackets the table could not be 
assigned to an archiving object. The size of the table for the first archiving 
object displays. The remaining archiving object values appear in brackets for 
which the table is available and whose value is not added to the total size of 
the object.
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An overview of analyzed tables displays if Single table evaluation 
was selected, as shown in Figure 73.

Figure 73 Table analysis overview

This alphabetical list displays table class. For example, the table 
AP_ORD_PRE is a view which is assigned to table AFKO. The sizes 
of both tables are the same.
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Double-click on a table to show the corresponding archiving objects. 
For example, the entry VBAK shows that the table is assigned to the 
archiving object SD_VBAK, as shown in Figure 74.

Figure 74 Table archiving assignation

The result of a capacity analysis without details is appears, as shown 
in Figure 75.

Figure 75 Capacity analysis without details
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ViewPoint for SAP modules are marked in red with the names of the 
archiving object for which they can be used displayed in the line 
below. ViewPoint for SAP modules used with multiple archiving 
objects display multiple times.

Note: ViewPoint for SAP module names are associated with the object on the 
line directly below. Objects without a ViewPoint for SAP module displayed 
directly above are not assigned to any ViewPoint for SAP module.

Comparison 
analysis

Use the ABAP /PBS/ANA_KAPAZITAET_VGL to compare two 
analysis runs, such as comparing data increase within a period of 
time or data decrease after archiving.

“Database analysis evaluation” on page 110 has information about 
Selections fields and Options for creating a second analysis for 
comparison purposes. 

The result of a comparison analysis appears, as shown in Figure 76. 
An increase in capacity means a loss of disk space and is displayed as 
a negative value highlighted in blue.

Figure 76 Comparison analysis results
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Capacity analysis 
display

The displayed total capacity is the sum of all archivable tables. An 
index created on the database level is not analyzed, unless it is a 
Microsoft SQL database index table. Otherwise, index table size is 
about 50% of the total capacity.

Movement data and master data not allocated to an archiving object 
is not included in the capacity analysis.
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Document distribution analysis
This section describes how to analyze document distribution using 
the ABAP/4 program /PBS/ANA_VERTEILUNG.

Initialization Before starting the first document distribution analysis the ViewPoint 
for SAP Database Analyzer Plus database tables must be 
reconstructed in the SAP R/3 system by starting the ABAP 
/PBS/ANA_ERSTAUFBAU by copying the entries of the database 
table /PBS/ANA_AR_DEF into the table /PBS/ANA_AR_OBJ, and 
supplementing it with the table names of the SQL database.

ABAP /PBS/ANA_ERSTAUFBAU is also used to delete all existing 
analyses.

Database analysis Use this procedure to run the document distribution analysis.

1. Start the ABAP /PBS/ANA_VERTEILUNG.

Note: Run the ABAP /PBS/ANA_VERTEILUNG as a background 
process checking the progress of the run with the protocol entries of the 
own jobs.

Depending on the database system, ABAP 
/PBS/ANA_VERTEILUNG starts a corresponding ABAP for the 
construction of the capacity analysis.
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The document distribution selection screen appears, as shown in 
Figure 77.

Figure 77 Document distribution selection screen

2. Enter information for the following fields.

Name document run —  Descriptive title for the analysis run.

From entry period - year —  Enter the beginning month and year for 
analysis.

To entry period - year —  Enter the ending month and year for 
analysis.

Module list area —  Select the modules to be included in the analysis 
run.

The analysis data is stored in database tables /PBS/ANA_BE_LFN 
and /PBS/ANA_BE_TXT under a sequential run number and can be 
analyzed as described next in “Analyze document distribution” on 
page 120.
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Analyze document 
distribution

Table 22 lists the ABAP/4 programs used for the document 
distribution analysis.

The following example follows the document distribution analysis 
for financial accounting with the program /PBS/ANA_BKPF.

Table 22 ABAP/4 area analysis

Program Area

/PBS/ANA_BKPF Document distribution financial accounting – BKPF

/PBS/ANA_VBUK Document distribution sales – VBUK

/PBS/ANA_EKKO Document distribution purchasing – EKKO

/PBS/ANA_COBK Document distribution cost accounting – COBK

/PBS/ANA_COEP Document distribution COEP

/PBS/ANA_AUFK Document distribution order

/PBS/ANA_MKPF Document distribution material document

/PBS/ANA_MARA Document distribution material record
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Starting /PBS/ANA_BKPF displays the financial accounting 
selection screen, as shown in Figure 78.

Figure 78 Financial accounting document distribution selection screen

Selections Client —  Enter the beginning and ending client number.

Company code —  Enter the beginning and ending company code.

Calendar year —  Enter the beginning and ending year.

Document type  —  Enter the beginning and ending document type 
number.

Document analysis run number —  Enter the sequential document 
analysis run number.

Sort by Assign a number from 1 to 5 to each sort criteria. To suppress a sort 
criterion leave that field blank. Ensure entered numbers are 
sequential and start with 1.

Doc. analys. —  Enables later archivability analysis for BKPF, VBUK, 
EKKO, COBK, and COEP.

Download results —  Downloads analysis results locally.
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A document distribution for financial accounting documents 
appears, as shown in Figure 79.

Figure 79 Document distribution financial accounting

Financial accounting document distribution values appear, as shown 
in Figure 80.

Figure 80 Financial accounting document distribution values

These document distribution values originate from capacity run 
number 0084 created with program /PBS/ANA_VERTEILUNG, and 
was constructed from period 01, year 1950 to period 12, year 2002. 
The average size of a document is 2,122 bytes which originated from 
the last capacity analysis. The run was stored with description TEST.
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Client 100 and company code 1000 contain a total of 2,8175 financial 
accounting documents, occupying a capacity of 58,386 KB, as shown 
in Figure 81.

Figure 81 Client/company code details

Branching to the 
archivability check

It is possible to check the archivability of documents in a certain 
period from within the distribution analysis by double-clicking the 
desired line of data if option Document analysis was selected, as 
shown in Figure 82.

Figure 82 Document analysis

Only documents belonging to the current client can be analyzed for 
archivability. The result of the check displays information, as shown 
in Figure 83.

Figure 83 Archive detail log

For the documents of client 100, company code S300, year 1999, 
document type AB of period 08, the archivability check shows that 
one of the associated documents has open items and cannot be 
archived.

Comments on the 
document 
distribution

The distribution of documents according to period and year uses 
entry date of the corresponding database table, except for the 
distribution of COEP records. This table does not contain an entry 
date and uses the fields year and period instead.
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Sales documents
using /PBS/ANA_VBUK

Table 23 lists the selection criteria for sales document objects.

Cost center line items
using /PBS/ANA_COEP

The the first two digits of field COEP-OBJNR are an important 
criterion for archiving cost center line items with CO_ITEM. 
Depending on the language used these two digits are substituted 
with a three-digit abbreviation. This allocation is defined in 
dictionary table TBO01.

Table 24 lists the two digits definitions.

Table 23 Sales document selection criteria

Selection Criteria Application

A Orders

L Delivery notes

F Invoices

Table 24 Cost Center Line Items selection criteria

Selection Criteria Object type

AO Reconciliation object

BP Business process

EO Result object

HP Cost object

IA, IB, IC, IG, IM, IV Real estate management

KL Cost center/activity type

KS Cost center 

NP Net plan 

NV Network activity 

OP Order item

OR Order 
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OV Operation 

PR PSP element

VB Sales document item 

Table 24 Cost Center Line Items selection criteria (continued)

Selection Criteria Object type
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Archivability check
The archivability check utility checks the archived status for 
archiving objects FI_DOCUMNT (financial accounting documents), 
SD_VBAK (orders), RV_LIKP (delivery notes), SD_VBRK (invoices), 
and MM_EKKO (purchase orders), and provides information about 
documents not archived.

Checking 
archivability

The archiving check of archiving objects FI_DOCUMNT, SD_VBAK, 
SD_VBRK, RV_LIKP, and MM_EKKO provides information about the 
transaction data in the SAP system and if that data fulfills the criteria 
for an archiving run after all business-related procedures are 
complete.

Financial 
accounting 
documents

The ABAP /PBS/ANA_ARCHIVE_FI_DOCUMNT provides an 
overview of all financial accounting documents for the delimited 
period and displays the reason if a document cannot be archived. 
Double-click a document for more details of an accounting 
document, as shown in Figure 84.

Figure 84 FI document selection results
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Sales documents Sales documents are analyzed and listed according to archiving 
objects for orders, invoices and delivery notes, displaying results for 
each document, as shown in Figure 85. Double-click a document for 
more details for a sales document. 

Figure 85 Sales orders selection results

The archivability checks carried out match the SAP archiving checks 
for orders, invoices, delivery notes as follows:

◆ orders — /PBS/ANA_ARCHIVE_SD_VBAK

◆ invoices — /PBS/ANA_ARCHIVE_SD_VBRK

◆ delivery notes — /PBS/ANA_ARCHIVE_RV_LIKP
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Purchasing 
documents

The archivability check for purchase orders matches checks carried 
out by SAP displaying results for each document, as shown in 
Figure 86. Double-click a document for additional document details. 

Figure 86 Purchasing document selection results

The ABAP for purchase orders is 
/PBS/ANA_ARCHIVE_MM_EKKO.

Forecast ViewPoint for SAP Analyzer Plus analyzes five archiving objects.

For more information contact EMC support.
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Capacity analysis examples
The output of all archiving objects belonging to the sales module 
appears using the following selection criteria, as shown in Figure 87:

◆ Selection — Application SD

◆ Formation of Pool — Archiving object

◆ Sorting — Size

◆ Options — Details

-------------------------------------------------------------------------------------------------
| PBS DB ANALYZER: PLATTENPLATZBELEGUNG VON ARCHIVOBJEKTEN Zeit    16:06:26   DOERRSCHUCK       |
| Kapazität Lauf-Nr. 0001 vom 19.02.1998 :     1.086.618  KB    Datum 20.02.1998                |
| Kapazitätsanalyse IDES, vor Archivierung                                         Seite     1  |
-------------------------------------------------------------------------------------------------
| Kapazität der selektierten Daten       :       113.586  KB                                    |
| Anteil Selektion am Lauf               :            10  %                                     |
-------------------------------------------------------------------------------------------------
| Objekt     Objektbezeichnung                                |    Summe (KB) | Sel (%) Ges (%) |
| Tabelle    Tabellenname                                     |    Größe (KB) | Sel (%) Ges (%) |
-------------------------------------------------------------------------------------------------
| SD_VBAK    Verkaufsbelege                                   |       60.027  |   52,8     5,5  |
| VBAP       Verkaufsbeleg: Positionsdaten                    |        7.729  |    6,8     0,7  |
| CKIS       Positionen Einzelkalkulation/Einzelnachweis Erz. |        6.922  |    6,1     0,6  |
| KEKO       Erzeugniskalkulation - Kopf                      |        6.762  |    6,0     0,6  |
| VBEP       Verkaufsbeleg: Einteilungsdaten                  |        4.666  |    4,1     0,4  |
| VBAK       Verkaufsbeleg: Kopfdaten                         |        4.017  |    3,5     0,4  |
| VBPA       Vertriebsbeleg: Partner                          |        3.993  |    3,5     0,4  |
| KONV       Konditionen (Vorgangsdaten)                      |        3.466  |    3,1     0,3  |
| VBFA       Vertriebsbelegfluß                               |        3.211  |    2,8     0,3  |
| CDPOS      Änderungsbelegpositionen                         |        2.468  |    2,2     0,2  |
| NAST       Nachrichtenstatus                                |        2.405  |    2,1     0,2  |
| STXH       STXD SAPscript Text-Datei Header                 |        1.853  |    1,6     0,2  |
| CKIT       Texte zu CKIS                                    |        1.812  |    1,6     0,2  |
| CMFP       Speicherstruktur für die gesammelten Fehler      |        1.512  |    1,3     0,1  |
| VBKD       Verkaufsbeleg: Kaufmännische Daten               |        1.509  |    1,3     0,1  |
| VAPMA      Vertriebsindex: Auftragspositionen zu Material   |        1.368  |    1,2     0,1  |
| VBUK       Vertriebsbeleg: Kopfstatus und Verwaltungsdaten  |        1.364  |    1,2     0,1  |
| KEPH       Herstellkostenelemente der Erzeugniskalkulation  |        1.257  |    1,1     0,1  |
| VAKPA      Vertriebsindex: Aufträge zu Partnerrollen        |        1.167  |    1,0     0,1  |
| VBUP       Vertriebsbeleg: Positionsstatus                  |        1.022  |    0,9     0,1  |
| CDHDR      Änderungsbelegkopf                               |          393  |    0,3     0,0  |
.
.
.
| SD_COND    Konditionssätze der Preisfindung                 |            7  |    0,0     0,0  |
| KONM       Konditionen (Mengenstaffel 1-dimensional)        |            5  |    0,0     0,0  |
| KONW       Konditionen (Wertstaffel 1-dimensional)          |            2  |    0,0     0,0  |
-------------------------------------------------------------------------------------------------

Figure 87 Sales module example
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The output of all archiving objects appears using the following sort 
according to size criteria, as shown in Figure 88:

◆ Formation of Pool — Archiving object
◆ Sorting — Size

| PBS DB ANALYZER: PLATTENPLATZBELEGUNG VON ARCHIVOBJEKTEN      Zeit    16:10:23   DOERRSCHUCK  |
| Kapazität Lauf-Nr. 0001 vom 19.02.1998 :     1.086.618  KB    Datum 20.02.1998                |
| Kapazitätsanalyse IDES, vor Archivierung                                         Seite     1  |
| Kapazität der selektierten Daten       :     1.086.618  KB                                    |
| Anteil Selektion am Lauf               :           100  %                                     |
| Objekt     Objektbezeichnung                                |    Summe (KB) | Sel (%) Ges (%) |
| FI_DOCUMNT Finanzbuchhaltungsbelege                         |      144.641  |   13,3    13,3  |
| CO_ORDER   Aufträge mit Bewegungsdaten                      |      138.780  |   12,8    12,8  |
| CO_ALLO_ST Vollständig stornierte Belege Umlage, Vert., ... |      118.075  |   10,9    10,9  |
| PCA_OBJECT Summensätze und Einzelposten im EC-PCA           |       94.101  |    8,7     8,7  |
| IDOC       Intermediate Document                            |       87.755  |    8,1     8,1  |
| SD_VBAK    Verkaufsbelege                                   |       60.027  |    5,5     5,5  |
| CO_COSTCTR Kostenstelle - alle Daten (incl.Stellenstamm)    |       43.488  |    4,0     4,0  |
| GLX-OBJEKT Summensätze und Einzelposten im FI-SL            |       41.440  |    3,8     3,8  |
| CV_DRAW    Summensätze und Einzelposten im FI-SL            |       39.173  |    3,6     3,6  |
| FLC_OBJECT Summensätze und Einzelposten im FI-LC            |       36.007  |    3,3     3,3  |
| PM_QMEL    PM-Meldungen                                     |       31.288  |    2,9     2,9  |
| SD_VBRK    Fakturen                                         |       31.074  |    2,9     2,9  |
| MM_EKKO    Einkaufsbelege                                   |       30.484  |    2,8     2,8  |
| FI_ACCOUNT Sachkontenstammdaten                             |       29.956  |    2,8     2,8  |
| RV_LIKP    Lieferungen                                      |       22.430  |    2,1     2,1  |
| MM_MATBEL  Materialwirtschaft: Materialbelege               |       20.437  |    1,9     1,9  |
| MM_MATNR   MM: Materialstamm                                |       17.588  |    1,6     1,6  |
| AM_ASSET   Anlage - Stammdaten, Werte und Bewegungen        |       15.960  |    1,5     1,5  |
| CATPROARCH CATT - Protokoll/Vorgang                         |       12.306  |    1,1     1,1  |
| CO_KSTRG   Kostenträger: Stammdaten und Bewegungsdaten      |       12.201  |    1,1     1,1  |
| CO_CCTR_EP Kostenstelle - Einzelposten                      |       11.042  |    1,0     1,0  |
| PM_EQUI    Equipmentstammdaten                              |       10.931  |    1,0     1,0  |
| CO_COPC    Archivierung Erzeugniskalkulationsdaten          |        8.648  |    0,8     0,8  |
| PP_WKC     Arbeitsplätze                                    |        5.947  |    0,5     0,5  |
| MM_EINA    Einkaufsinfosätze                                |        5.585  |    0,5     0,5  |
| FI_ACCRECV Debitorenstammdaten                              |        3.102  |    0,3     0,3  |
| QM_CONTROL Bewegungsdaten der Q-Prüfung                     |        2.450  |    0,2     0,2  |
| FI_MONTHLY Verkehrszahlen von Debitor/Kreditor/Sachkonten   |        2.106  |    0,2     0,2  |
| CO_BASEOBJ COPC: Bauteil                                    |        1.814  |    0,2     0,2  |
| PM_ORDER   PM-Auftrag                                       |        1.488  |    0,1     0,1  |
| PS_PROJECT Projektsystem: Operative Strukturen              |          871  |    0,1     0,1  |
| FI_ACCPAYB Kreditorstammdaten                               |          828  |    0,1     0,1  |
| PM_IFLOT   Technischer Platz Stammdaten                     |          696  |    0,1     0,1  |
| PP_ORDER   Technischer Platz Stammdaten                     |          683  |    0,1     0,1  |
| FI_SCHECK  Vornumerierte Schecks                            |          545  |    0,1     0,1  |
| MM_REBEL   Materialwirtschaft: Rechnungsbelege              |          494  |    0,0     0,0  |
| MM_SPSTOCK MM: Sonderbestände                               |          428  |    0,0     0,0  |
| MM_ASMD    Leistungsstamm                                   |          405  |    0,0     0,0  |
| QM_QMEL    Qualitätsmeldung                                 |          339  |    0,0     0,0  |
| RL_TA      MM-WM Lagerverwaltung: Transportaufträge         |          156  |    0,0     0,0  |
| MC_SELVS   LIS: Gespeicherte Selektionsversionen            |          142  |    0,0     0,0  |
| QM_CHARACT QM-Stammprüfmerkmale                             |          134  |    0,0     0,0  |
| PR_ORDER   Prozeßauftrag                                    |          133  |    0,0     0,0  |
| CO_ML_ML1  Periodensätze des Material Ledger (CKML1)        |           84  |    0,0     0,0  |
| BC_ARCHIVE Archivierung der Archivadministrationsdaten      |           78  |    0,0     0,0  |
| EXAMPLE    Beispielobjekt                                   |           62  |    0,0     0,0  |
| SD_VBKA    Kontakte                                         |           39  |    0,0     0,0  |
| FILENAME   Beispielobjekt für die Archivierung              |           32  |    0,0     0,0  |
| FI_BANKS   Bankstammdaten                                   |           29  |    0,0     0,0  |
| RL_TB      MM-WM Lagerverwaltung: Transportbedarfe          |           28  |    0,0     0,0  |
| PPPI_ARCH  Prozeßauftrag: DB-Archivieren                    |           18  |    0,0     0,0  |
| CO_ML_IDX  Indexeinträge Belege zum Material: Material Ledg |           17  |    0,0     0,0  |
| CA_KBLX    Interne RW-Belege (Mittelreserv./Festpreise/...) |           13  |    0,0     0,0  |
| PS_TEXT    Projektsystem: PS-Texte                          |           10  |    0,0     0,0  |
| SD_VTTK    SD Transporte                                    |           10  |    0,0     0,0  |
| PI_PLAN    Planungsrezept                                   |            3  |    0,0     0,0  |
| PP_PLAN    Arbeitspläne                                     |            1  |    0,0     0,0  |

Figure 88 Archiving objects example
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The output using the size of the archive table NAST appears with the 
distribution of the archiving objects, as shown in Figure 89.

◆ Selection — Archive table: NAST

◆ Formation of Pos — None

◆ Sorting — Size

◆ Options — Zero values, details
-------------------------------------------------------------------------------------------------
| PBS DB ANALYZER: PLATTENPLATZBELEGUNG VON ARCHIVOBJEKTEN      Zeit    16:11:55   DOERRSCHUCK  |
| Kapazität Lauf-Nr. 0001 vom 19.02.1998 :     1.086.618  KB    Datum 20.02.1998                |
| Kapazitätsanalyse IDES, vor Archivierung                                         Seite     1  |
-------------------------------------------------------------------------------------------------
| Kapazität der selektierten Daten       :         8.841  KB                                    |
| Anteil Selektion am Lauf               :             1  %                                     |
-------------------------------------------------------------------------------------------------
| Tabelle    Object     Bezeichnung                           |    Größe (KB) | Sel (%) Ges (%) |
-------------------------------------------------------------------------------------------------
| NAST       SD_VBRK    Nachrichtenstatus                     |        2.433  |   27,5     0,2  |
| NAST       SD_VBAK    Nachrichtenstatus                     |        2.405  |   27,2     0,2  |
| NAST       MM_EKKO    Nachrichtenstatus                     |        2.316  |   26,2     0,2  |
| NAST       RV_LIKP    Nachrichtenstatus                     |        1.683  |   19,0     0,2  |
| NAST       SD_VBKA    Nachrichtenstatus                     |            3  |    0,0     0,0  |
| NAST       SD_VTTK    Nachrichtenstatus                     |            2  |    0,0     0,0  |
-------------------------------------------------------------------------------------------------

Figure 89 Archive table example
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The determination of the document size for the archiving objects 
appears from the applications SD, MM, and FI using the following 
criteria, as shown in Figure 90:

Selection — Application: SD, MM, FI

Formation of Pool — Archiving object

Sorting — Size

Options — Determine document size, zero values

--------------------------------------------------------------------------------
-----------------

| PBS DB ANALYZER: PLATTENPLATZBELEGUNG VON ARCHIVOBJEKTEN      Zeit    16:13:49   DOERRSCHUCK  |
| Kapazität Lauf-Nr. 0001 vom 19.02.1998 :     1.086.618  KB    Datum 20.02.1998                |
| Kapazitätsanalyse IDES, vor Archivierung                                         Seite     1  |
-------------------------------------------------------------------------------------------------
| Kapazität der selektierten Daten       :       402.483  KB                                    |
| Anteil Selektion am Lauf               :            37  %                                     |
-------------------------------------------------------------------------------------------------
| Objekt     Objektbezeichnung                                |    Summe (KB) | Sel (%) Ges (%) |
-------------------------------------------------------------------------------------------------
| FI_DOCUMNT Finanzbuchhaltungsbelege                         |      144.641  |   35,9    13,3  |
|            BKPF       Anz.:      90.074     Byte:    1.644  |               |                 |
| SD_VBAK    Verkaufsbelege                                   |       60.027  |   14,9     5,5  |
|            VBAK       Anz.:      10.041     Byte:    6.122  |               |                 |
| FLC_OBJECT Summensätze und Einzelposten im FI-LC            |       36.007  |    8,9     3,3  |
| SD_VBRK    Fakturen                                         |       31.074  |    7,7     2,9  |
|            VBRK       Anz.:      10.155     Byte:    3.133  |               |                 |
| MM_EKKO    Einkaufsbelege                                   |       30.484  |    7,6     2,8  |
|            EKKO       Anz.:       9.669     Byte:    3.228  |               |                 |
| FI_ACCOUNT Sachkontenstammdaten                             |       29.956  |    7,4     2,8  |
|            SKA1       Anz.:      47.149     Byte:      651  |               |                 |
| RV_LIKP    Lieferungen                                      |       22.430  |    5,6     2,1  |
|            LIKP       Anz.:       7.024     Byte:    3.270  |               |                 |
| MM_MATBEL  Materialwirtschaft: Materialbelege               |       20.437  |    5,1     1,9  |
| MM_MATNR   MM: Materialstamm                                |       17.588  |    4,4     1,6  |
|            MARA       Anz.:       2.810     Byte:    6.409  |               |                 |
| MM_EINA    Einkaufsinfosätze                                |        5.585  |    1,4     0,5  |
|            EINA       Anz.:       2.217     Byte:    2.579  |               |                 |
.
.
.
| SD_VBKA    Kontakte                                         |           39  |    0,0     0,0  |
|            VBKA       Anz.:          12     Byte:    3.287  |               |                 |
| FI_BANKS   Bankstammdaten                                   |           29  |    0,0     0,0  |
| RL_TB      MM-WM Lagerverwaltung: Transportbedarfe          |           28  |    0,0     0,0  |
| SD_VTTK    SD Transporte                                    |           10  |    0,0     0,0  |
|            VTTK       Anz.:           8     Byte:    1.243  |               |                 |
| SD_COND    Konditionssätze der Preisfindung                 |            7  |    0,0     0,0  |
|            KONH       Anz.:      13.726     Byte:        1  |               |                 |
| RL_LINV    MM-WM Lagerverwaltung: Inventurzählsätze Histori |            6  |    0,0     0,0  |
| MM_INVBEL  Materialwirtschaft: Inventurbelege               |            4  |    0,0     0,0  |
| FM_BELEG   Obligo/Ist Einzelposten - Finanzbudgetmanagement |            0  |    0,0     0,0  |
| FM_BEL_CA  Obligo/Ist Einzelposten - Finanzmittelrechnung   |            0  |    0,0     0,0  |
| RL_LINKP   MM-WM Lagerverwaltung: Inventuraufnahmebelege    |            0  |    0,0     0,0  |
| RL_LUBU    MM-WM Lagerverwaltung: Umbuchungsanweisungen     |            0  |    0,0     0,0  |
-------------------------------------------------------------------------------------------------

Figure 90 Document size example
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Analyzer Plus
Document distribution analysis examples
An overview of the number of posted documents for each period 
appears using company code client 800, as shown in Figure 91.

Selection — Client 800, entry year 1995

Formation of Pool — 1. Client, 2. Company code, 3. Posting period

------------------------------------------------------------------------------
| PBS DB ANALYZER: VERTEILUNG BUCHHALTUNGSBELEGE                DOERRSCHUCK  |
| Lauf 0001: 01/1990 - 12/1998              Datum 23.02.1998    /PBS/ANA_BKPF|
| Beleggröße (Byte) 1.644                                                    |
| BELEGVERTEILUNG IDES                                          Seite     1  |
------------------------------------------------------------------------------
| MANDT  BUKRS  PERIOD               | Anzahl       | Größe (KB)   | Größe % |
------------------------------------------------------------------------------
| 800    0001   06                   |           1  |           2  |   0,02  |
------------------------------------------------------------------------------
| 800    0001   **                   |           1  |           2  |   0,02  |
------------------------------------------------------------------------------
| 800    1000   01                   |         162  |         260  |   3,84  |
| 800    1000   02                   |         106  |         170  |   2,51  |
| 800    1000   03                   |          47  |          75  |   1,11  |
| 800    1000   04                   |          50  |          80  |   1,18  |
| 800    1000   05                   |         557  |         894  |  13,20  |
| 800    1000   06                   |         776  |       1.246  |  18,39  |
| 800    1000   07                   |         351  |         564  |   8,32  |
| 800    1000   08                   |         181  |         291  |   4,29  |
| 800    1000   09                   |         206  |         331  |   4,88  |
| 800    1000   10                   |         137  |         220  |   3,25  |
| 800    1000   11                   |         119  |         191  |   2,82  |
| 800    1000   12                   |         246  |         395  |   5,83  |
------------------------------------------------------------------------------
| 800    1000   **                   |       2.938  |       4.717  |  69,62  |
------------------------------------------------------------------------------
| 800    2000   01                   |           3  |           5  |   0,07  |
| 800    2000   02                   |           2  |           3  |   0,05  |
.
.
| 800    3000   10                   |          99  |         159  |   2,35  |
| 800    3000   11                   |         231  |         371  |   5,47  |
| 800    3000   12                   |          61  |          98  |   1,45  |
------------------------------------------------------------------------------
| 800    3000   **                   |         841  |       1.350  |  19,93  |
------------------------------------------------------------------------------
| 800    4000   05                   |           1  |           2  |   0,02  |
| 800    4000   10                   |          68  |         109  |   1,61  |
| 800    4000   11                   |          39  |          63  |   0,92  |
------------------------------------------------------------------------------
| 800    4000   **                   |         108  |         173  |   2,56  |
------------------------------------------------------------------------------
| 800    4200   05                   |           1  |           2  |   0,02  |
------------------------------------------------------------------------------
| 800    4200   **                   |           1  |           2  |   0,02  |
------------------------------------------------------------------------------
| 800    US01   11                   |         128  |         206  |   3,03  |
------------------------------------------------------------------------------
| 800    US01   **                   |         128  |         206  |   3,03  |
------------------------------------------------------------------------------
| 800    ****   **                   |       4.220  |       6.775  | 100,00  |
------------------------------------------------------------------------------
| ***    ****   **                   |       4.220  |       6.775  | 100,00  |
------------------------------------------------------------------------------

Figure 91 Posted documents example
Document distribution analysis examples 133



134

Analyzer Plus
Document volume periods from 1995 to 1996 appears with 
corresponding company codes for all clients, as shown in Figure 92.

Selection — Entry year 1995 - 1996

Formation of Pool — 1. Posting year, 2. Posting period, 3. Company 
code

------------------------------------------------------------------------------
| PBS DB ANALYZER: VERTEILUNG BUCHHALTUNGSBELEGE                DOERRSCHUCK  |
| Lauf 0001: 01/1990 - 12/1998              Datum 23.02.1998    /PBS/ANA_BKPF|
| Beleggröße (Byte) 1.644                                                    |
| BELEGVERTEILUNG IDES                                          Seite     1  |
------------------------------------------------------------------------------
| JAHR   PERIOD BUKRS                | Anzahl       | Größe (KB)   | Größe % |
------------------------------------------------------------------------------
| 1995   01     1000                 |         324  |         520  |   0,51  |
| 1995   01     2000                 |           6  |          10  |   0,01  |
| 1995   01     3000                 |         722  |       1.159  |   1,13  |
------------------------------------------------------------------------------
| 1995   01     ****                 |       1.052  |       1.689  |   1,64  |
------------------------------------------------------------------------------
| 1995   02     1000                 |         212  |         340  |   0,33  |
| 1995   02     2000                 |           4  |           6  |   0,01  |
| 1995   02     3000                 |          42  |          67  |   0,07  |
------------------------------------------------------------------------------
| 1995   02     ****                 |         258  |         414  |   0,40  |
------------------------------------------------------------------------------
| 1995   03     1000                 |          94  |         151  |   0,15  |
| 1995   03     3000                 |          36  |          58  |   0,06  |
------------------------------------------------------------------------------
| 1995   03     ****                 |         130  |         209  |   0,20  |
------------------------------------------------------------------------------
| 1995   04     1000                 |         100  |         161  |   0,16  |
| 1995   04     2000                 |           2  |           3  |   0,00  |
| 1995   04     3000                 |          22  |          35  |   0,03  |
------------------------------------------------------------------------------
| 1995   04     ****                 |         124  |         199  |   0,19  |
------------------------------------------------------------------------------
| 1995   05     1000                 |       1.114  |       1.788  |   1,74  |
| 1995   05     2000                 |         288  |         462  |   0,45  |
| 1995   05     3000                 |          56  |          90  |   0,09  |
| 1995   05     4000                 |           2  |           3  |   0,00  |
| 1995   05     4200                 |           2  |           3  |   0,00  |
------------------------------------------------------------------------------
| 1995   05     ****                 |       1.462  |       2.347  |   2,28  |
------------------------------------------------------------------------------
| 1996   10     3000                 |         152  |         244  |   0,24  |
------------------------------------------------------------------------------
| 1996   10     ****                 |       3.902  |       6.265  |   6,09  |
------------------------------------------------------------------------------
| 1996   11     1000                 |       3.744  |       6.011  |   5,85  |
| 1996   11     2000                 |         274  |         440  |   0,43  |
| 1996   11     3000                 |         294  |         472  |   0,46  |
------------------------------------------------------------------------------
| 1996   11     ****                 |       4.312  |       6.923  |   6,73  |
------------------------------------------------------------------------------
| 1996   12     1000                 |       3.240  |       5.202  |   5,06  |
| 1996   12     2000                 |         272  |         437  |   0,42  |
| 1996   12     3000                 |         170  |         273  |   0,27  |
| 1996   12     4000                 |           4  |           6  |   0,01  |
------------------------------------------------------------------------------
| 1996   12     ****                 |       3.686  |       5.918  |   5,76  |
------------------------------------------------------------------------------
| 1996   **     ****                 |      55.535  |      89.160  |  86,72  |
------------------------------------------------------------------------------
| ****   **     ****                 |      64.043  |     102.819  | 100,00  |

Figure 92 Document volume example
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Analyzer Plus
The number of posted documents by document type and year for 
client 800 appears, as shown in Figure 93.

Selection — Client 800

Formation of Pool — 1. Document type, 2. Posting year

------------------------------------------------------------------------------
| PBS DB ANALYZER: VERTEILUNG BUCHHALTUNGSBELEGE                DOERRSCHUCK  |
| Lauf 0001: 01/1990 - 12/1998              Datum 23.02.1998    /PBS/ANA_BKPF|
| Beleggröße (Byte) 1.644                                                    |
| BELEGVERTEILUNG IDES                                          Seite     1  |
------------------------------------------------------------------------------
| BLART  JAHR                        | Anzahl       | Größe (KB)   | Größe % |
------------------------------------------------------------------------------
| AA     1994                        |         130  |         209  |   0,29  |
| AA     1995                        |         166  |         267  |   0,37  |
| AA     1996                        |          24  |          39  |   0,05  |
| AA     1997                        |         182  |         292  |   0,40  |
------------------------------------------------------------------------------
| AA     ****                        |         502  |         806  |   1,12  |
------------------------------------------------------------------------------
| AB     1994                        |          13  |          21  |   0,03  |
| AB     1995                        |         267  |         429  |   0,59  |
| AB     1996                        |         108  |         173  |   0,24  |
| AB     1997                        |          25  |          40  |   0,06  |
------------------------------------------------------------------------------
| AB     ****                        |         413  |         663  |   0,92  |
------------------------------------------------------------------------------
| AF     1994                        |         339  |         544  |   0,75  |
| AF     1995                        |         722  |       1.159  |   1,60  |
| AF     1996                        |       1.363  |       2.188  |   3,03  |
| AF     1997                        |         172  |         276  |   0,38  |
------------------------------------------------------------------------------
| AF     ****                        |       2.596  |       4.168  |   5,77  |
------------------------------------------------------------------------------
| AN     1994                        |           1  |           2  |   0,00  |
| AN     1995                        |           1  |           2  |   0,00  |
------------------------------------------------------------------------------
| AN     ****                        |           2  |           3  |   0,00  |
------------------------------------------------------------------------------
| DA     1995                        |           1  |           2  |   0,00  |
| DA     1996                        |           2  |           3  |   0,00  |
------------------------------------------------------------------------------
| DA     ****                        |           3  |           5  |   0,01  |
------------------------------------------------------------------------------
| DG     1996                        |           2  |           3  |   0,00  |
------------------------------------------------------------------------------
| DG     ****                        |           2  |           3  |   0,00  |
------------------------------------------------------------------------------
| DR     1994                        |       6.093  |       9.782  |  13,54  |
| DR     1995                        |         298  |         478  |   0,66  |
| KA     1995                        |          51  |          82  |   0,11  |
.
.
.
| WL     1997                        |         221  |         355  |   0,49  |
------------------------------------------------------------------------------
| WL     ****                        |       3.354  |       5.385  |   7,46  |
------------------------------------------------------------------------------
| ZP     1994                        |          21  |          34  |   0,05  |
| ZP     1995                        |          96  |         154  |   0,21  |
| ZP     1996                        |         117  |         188  |   0,26  |
| ZP     1997                        |          74  |         119  |   0,16  |
------------------------------------------------------------------------------
| ZP     ****                        |         308  |         494  |   0,68  |
------------------------------------------------------------------------------
| **     ****                        |      44.987  |      72.225  | 100,00  |
------------------------------------------------------------------------------

Figure 93 Posted documents by type example
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Analyzer Plus
The document volume of company codes in different clients appears, 
as shown in Figure 94.

Selection — Entry year 1995 - 1996

Formation of Pool — 1. Posting year, 2. Posting period, 3. Company 
code

------------------------------------------------------------------------------
| PBS DB ANALYZER: VERTEILUNG BUCHHALTUNGSBELEGE                DOERRSCHUCK  |
| Lauf 0001: 01/1990 - 12/1998              Datum 23.02.1998    /PBS/ANA_BKPF|
| Beleggröße (Byte) 1.644                                                    |
| BELEGVERTEILUNG IDES                                          Seite     1  |
------------------------------------------------------------------------------
| MANDT  BUKRS                       | Anzahl       | Größe (KB)   | Größe % |
------------------------------------------------------------------------------
| 100    0001                        |           1  |           2  |   0,00  |
| 100    1000                        |      32.231  |      51.746  |  35,78  |
| 100    2000                        |       2.597  |       4.169  |   2,88  |
| 100    2100                        |          32  |          51  |   0,04  |
| 100    2200                        |           4  |           6  |   0,00  |
| 100    3000                        |       9.648  |      15.490  |  10,71  |
| 100    4000                        |         229  |         368  |   0,25  |
| 100    4200                        |           1  |           2  |   0,00  |
| 100    6000                        |          48  |          77  |   0,05  |
| 100    US01                        |         200  |         321  |   0,22  |
------------------------------------------------------------------------------
| 100    ****                        |      44.991  |      72.232  |  49,95  |
------------------------------------------------------------------------------
| 800    0001                        |           1  |           2  |   0,00  |
| 800    1000                        |      32.227  |      51.739  |  35,78  |
| 800    2000                        |       2.597  |       4.169  |   2,88  |
| 800    2100                        |          32  |          51  |   0,04  |
| 800    2200                        |           4  |           6  |   0,00  |
| 800    3000                        |       9.648  |      15.490  |  10,71  |
| 800    4000                        |         229  |         368  |   0,25  |
| 800    4200                        |           1  |           2  |   0,00  |
| 800    6000                        |          48  |          77  |   0,05  |
| 800    US01                        |         200  |         321  |   0,22  |
------------------------------------------------------------------------------
| 800    ****                        |      44.987  |      72.225  |  49,95  |
------------------------------------------------------------------------------
| 810    1000                        |          24  |          39  |   0,03  |
------------------------------------------------------------------------------
| 810    ****                        |          24  |          39  |   0,03  |
------------------------------------------------------------------------------
| 811    2100                        |          71  |         114  |   0,08  |
------------------------------------------------------------------------------
| 811    ****                        |          71  |         114  |   0,08  |
------------------------------------------------------------------------------
| ***    ****                        |      90.073  |     144.609  | 100,00  |
------------------------------------------------------------------------------

Figure 94 Document volume by type example
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